You can find the most up-to-date technical documentation on the VMware website at:
https://docs.vmware.com/
If you have comments about this documentation, submit your feedback to
docfeedback@vmware.com
# Contents

About VMware Site Recovery Manager Installation and Configuration 5

Updated Information 6

1 Overview of VMware Site Recovery Manager 7
   About Protected Sites and Recovery Sites 8
   Bidirectional Protection 9
   Heterogeneous Configurations on the Protected and Recovery Sites 10

2 Site Recovery Manager System Requirements 12
   Site Recovery Manager Licensing 13
   Operational Limits of Site Recovery Manager 14

3 Creating the Site Recovery Manager Database 15
   Requirements when Using Microsoft SQL Server with Site Recovery Manager 16
   Requirements for Using Oracle Server with Site Recovery Manager 17
   Back Up and Restore the Embedded vPostgres Database 18
   Create an ODBC System DSN for Site Recovery Manager 19

4 Site Recovery Manager Authentication 21

5 Creating SSL/TLS Server Endpoint Certificates for Site Recovery Manager 23
   Requirements When Using Custom SSL/TLS Certificates with Site Recovery Manager 23

6 Installing Site Recovery Manager 26
   Site Recovery Manager and vCenter Server Deployment Models 27
   Prerequisites and Best Practices for Site Recovery Manager Server Installation 32
   Install Site Recovery Manager Server 34
   Connect the Site Recovery Manager Server Instances on the Protected and Recovery Sites 39
   Establish a Client Connection to the Remote Site Recovery Manager Server Instance 39
   Install the Site Recovery Manager License Key 40
   Site Recovery Manager Server Does Not Start 40
   Unregister an Incompatible Version of vSphere Replication 43

7 Modifying and Uninstalling Site Recovery Manager 44
   Modify a Site Recovery Manager Server Installation 45
   Reconfigure the Connection Between Sites 48
   Break the Site Pairing and Connect to a New Remote Site 49
Repair a Site Recovery Manager Server Installation  50
Rename a Site Recovery Manager Site  51
Uninstall Site Recovery Manager  51
Uninstall and Reinstall the Same Version of Site Recovery Manager  53

8 Upgrading Site Recovery Manager  58
Information That Site Recovery Manager Upgrade Preserves  58
Types of Upgrade that Site Recovery Manager Supports  60
Upgrade Site Recovery Manager  61

9 Installing Site Recovery Manager to Use with a Shared Recovery Site  76
Shared Recovery Sites and vCenter Server Deployment Models  78
Limitations of Using Site Recovery Manager in Shared Recovery Site Configuration  80
Site Recovery Manager Licenses in a Shared Recovery Site Configuration  82
Install Site Recovery Manager In a Shared Recovery Site Configuration  83
Upgrade Site Recovery Manager in a Shared Recovery Site Configuration  90
About VMware Site Recovery Manager Installation and Configuration

Site Recovery Manager Installation and Configuration provides information about how to install, upgrade, and configure VMware Site Recovery Manager.

This information also provides a general overview of Site Recovery Manager.

For information about how to perform day-to-day administration of Site Recovery Manager, see Site Recovery Manager Administration.

Intended Audience

This information is intended for anyone who wants to install, upgrade, or configure Site Recovery Manager. The information is written for experienced Windows or Linux system administrators who are familiar with virtual machine technology and datacenter operations.
Updated Information

*Site Recovery Manager Installation and Configuration* is updated with each release of the product or when necessary.

This table provides the update history of *Site Recovery Manager Installation and Configuration*.

<table>
<thead>
<tr>
<th>Revision</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>EN-001771-04</td>
<td>Updated the information in Chapter 4 Site Recovery Manager Authentication.</td>
</tr>
<tr>
<td>EN-001771-03</td>
<td>Updated the information about the embedded vPostgreSQL database in Chapter 3 Creating the Site Recovery Manager Database.</td>
</tr>
<tr>
<td>EN-001771-02</td>
<td>Updated Requirements When Using Custom SSL/TLS Certificates with Site Recovery Manager with new requirements for public authority certificates with internal server names.</td>
</tr>
<tr>
<td>EN-001771-01</td>
<td>Replaced &quot;federated environment&quot; with &quot;Enhanced Linked Mode&quot; throughout.</td>
</tr>
<tr>
<td>EN-001771-00</td>
<td>Initial release.</td>
</tr>
</tbody>
</table>
Overview of VMware Site Recovery Manager

VMware Site Recovery Manager is a business continuity and disaster recovery solution that helps you to plan, test, and run the recovery of virtual machines between a protected vCenter Server site and a recovery vCenter Server site.

You can configure Site Recovery Manager to protect virtual machines in different ways.

**Datastore groups**
Protect the virtual machines in datastore groups by using third-party disk replication mechanisms to configure array-based replication. Array-based replication surfaces replicated datastores to recover virtual machine workloads.

**Individual virtual machines**
Protect the individual virtual machines on a host by using Site Recovery Manager in combination with VMware vSphere Replication.

**Storage policies**
Protect virtual machines based on their association with specific storage policies. Protecting virtual machines by using storage policies requires array-based replication.

You can use Site Recovery Manager to implement different types of recovery from the protected site to the recovery site.

**Planned migration**
The orderly evacuation of virtual machines from the protected site to the recovery site. Planned migration prevents data loss when migrating workloads in an orderly fashion. For planned migration to succeed, both sites must be running and fully functioning.

**Disaster recovery**
Similar to planned migration except that disaster recovery does not require that both sites be up and running, for example if the protected site goes offline unexpectedly. During a disaster recovery operation, failure of operations on the protected site is reported but is otherwise ignored.

Site Recovery Manager orchestrates the recovery process with the replication mechanisms, to minimize data loss and system down time.

- At the protected site, Site Recovery Manager shuts down virtual machines cleanly and synchronizes storage, if the protected site is still running.
- Site Recovery Manager powers on the replicated virtual machines at the recovery site according to a recovery plan.
A recovery plan specifies the order in which virtual machines start up on the recovery site. A recovery plan specifies network parameters, such as IP addresses, and can contain user-specified scripts that Site Recovery Manager can run to perform custom recovery actions on virtual machines.

Site Recovery Manager lets you test recovery plans. You conduct tests by using a temporary copy of the replicated data in a way that does not disrupt ongoing operations at either site.

- **About Protected Sites and Recovery Sites**
  
  In a typical Site Recovery Manager installation, the protected site provides business-critical datacenter services. The recovery site is an alternative infrastructure to which Site Recovery Manager can migrate these services.

- **Bidirectional Protection**
  
  You can use a single set of paired Site Recovery Manager sites to protect virtual machines in both directions. Each site can simultaneously be a protected site and a recovery site, but for a different set of virtual machines.

- **Heterogeneous Configurations on the Protected and Recovery Sites**
  
  Some components in the Site Recovery Manager and vCenter Server installations must be identical on each site. Because the protected and recovery sites are often in different physical locations, some components on the protected site can be of a different type to their counterparts on the recovery site.

**About Protected Sites and Recovery Sites**

In a typical Site Recovery Manager installation, the protected site provides business-critical datacenter services. The recovery site is an alternative infrastructure to which Site Recovery Manager can migrate these services.

The protected site can be any site where vCenter Server supports a critical business need. The recovery site can be located thousands of miles away from the protected site. Conversely, the recovery site can be in the same room as a way of establishing redundancy. The recovery site is usually located in a facility that is unlikely to be affected by environmental, infrastructure, or other disturbances that affect the protected site. You can establish bidirectional protection in which each site serves as the recovery site for the other. See **Bidirectional Protection**.

**Figure 1-1. Site Recovery Manager Protected and Recovery Sites**

Virtual machines replicate from site A to site B
The vSphere configurations at each site must meet requirements for Site Recovery Manager.

- You must run the same version of Site Recovery Manager on both sites.
- You must run the same version of vCenter Server on both sites.
- The version of vCenter Server must be compatible with the version of Site Recovery Manager. For information about compatibility between vCenter Server and Site Recovery Manager versions, see vCenter Server Requirements in the Compatibility Matrixes for Site Recovery Manager 6.1 at https://www.vmware.com/support/srm/srm-compat-matrix-6-1.html.
- Each site must have at least one datacenter.
- If you are using array-based replication, the same replication technology must be available at both sites, and the arrays must be paired.
- If you are using vSphere Replication, you require a vSphere Replication appliance on both sites. The vSphere Replication appliances must be connected to each other.
- The vSphere Replication appliances must be of the same version.
- The vSphere Replication version must be compatible with the version of Site Recovery Manager. For information about compatibility between vSphere Replication and Site Recovery Manager versions, see vSphere Replication Requirements in the Compatibility Matrixes for Site Recovery Manager 6.1 at https://www.vmware.com/support/srm/srm-compat-matrix-6-1.html.
- The recovery site must have hardware, network, and storage resources that can support the same virtual machines and workloads as the protected site. You can oversubscribe the recovery site by running additional virtual machines there that are not protected. In this case, during a recovery you must suspend noncritical virtual machines on the recovery site.
- The sites must be connected by a reliable IP network. If you are using array-based replication, ensure that your network connectivity meets the arrays’ network requirements.
- The recovery site should have access to comparable public and private networks as the protected site, although not necessarily the same range of network addresses.

**Bidirectional Protection**

You can use a single set of paired Site Recovery Manager sites to protect virtual machines in both directions. Each site can simultaneously be a protected site and a recovery site, but for a different set of virtual machines.

You can implement bidirectional protection by protecting datastore groups or storage policies by using array-based replication or by protecting individual virtual machines by using vSphere Replication. If you are using array-based replication, each of the array’s LUNs replicates in only one direction. Two LUNs in paired arrays can replicate in different directions from each other.
Heterogeneous Configurations on the Protected and Recovery Sites

Some components in the Site Recovery Manager and vCenter Server installations must be identical on each site. Because the protected and recovery sites are often in different physical locations, some components on the protected site can be of a different type to their counterparts on the recovery site.

Although components can be different on each site, you must use the types and versions of these components that Site Recovery Manager supports. See the Compatibility Matrixes for Site Recovery Manager 6.1 at https://www.vmware.com/support/srm/srm-compat-matrix-6-1.html for information.

Table 1-1. Heterogeneity of Site Recovery Manager Components Between Sites

<table>
<thead>
<tr>
<th>Component</th>
<th>Heterogeneous or Identical Installations</th>
</tr>
</thead>
<tbody>
<tr>
<td>Site Recovery Manager Server</td>
<td>Must be the same version on both sites.</td>
</tr>
<tr>
<td>vCenter Server and Platform Services Controller</td>
<td>Must be the same version on both sites. The Site Recovery Manager version must be compatible with the vCenter Server and Platform Services Controller version.</td>
</tr>
<tr>
<td>vSphere Replication</td>
<td>Must be the same version on both sites. The vSphere Replication version must be compatible with the Site Recovery Manager version and the vCenter Server version.</td>
</tr>
<tr>
<td>vCenter Server Appliance or standard vCenter Server instance</td>
<td>Can be different on each site. You can run a vCenter Server Appliance on one site and a standard vCenter Server instance on the other site.</td>
</tr>
<tr>
<td>Storage arrays for array-based replication</td>
<td>Can be different versions on each site. You can use different versions of the same type of storage array on each site. The Site Recovery Manager Server instance on each site requires the appropriate storage replication adapter (SRA) for each version of storage array for that site. Check SRA compatibility with all versions of your storage arrays to ensure compatibility.</td>
</tr>
<tr>
<td>Site Recovery Manager database</td>
<td>Can be different on each site. You can use different versions of the same type of database on each site, or different types of database on each site.</td>
</tr>
<tr>
<td>Host operating system of the Site Recovery Manager Server installation</td>
<td>Can be different on each site. You can run different versions of the host operating system and the host operating system can run in different locales on each site.</td>
</tr>
<tr>
<td>Host operating system of the vCenter Server installation</td>
<td>Can be different on each site. You can run different versions of the host operating system and the host operating system can run in different locales on each site.</td>
</tr>
</tbody>
</table>
Example: Heterogenous Configurations on the Protected and Recovery Sites

The Site Recovery Manager and vCenter Server installations might be in different countries, with different setups.

- Site A in Japan:
  - Site Recovery Manager Server runs on Windows Server 2008 in the Japanese locale
  - Site Recovery Manager extends a vCenter Server Appliance instance
  - Site Recovery Manager Server uses the embedded Site Recovery Manager database

- Site B in the United States:
  - Site Recovery Manager Server runs on Windows Server 2012 in the English locale
  - Site Recovery Manager extends a standard vCenter Server instance that runs on Windows Server 2008 in the English locale
  - Site Recovery Manager Server uses an Oracle Server database
The system on which you install Site Recovery Manager must meet specific hardware requirements.

### Table 2-1. Minimum Site Recovery Manager System Requirements

<table>
<thead>
<tr>
<th>Component</th>
<th>Requirement</th>
</tr>
</thead>
<tbody>
<tr>
<td>Processor</td>
<td>At least two 2.0GHz or higher Intel or AMD x86 processors. Site Recovery Manager deployments that manage large environments require four 2.0GHz CPUs.</td>
</tr>
<tr>
<td>Memory</td>
<td>2GB minimum. You might require more memory if you use the embedded database, as the content of the database grows. The memory requirement increases if Site Recovery Manager manages large environments.</td>
</tr>
<tr>
<td>Disk Storage</td>
<td>5GB minimum. If you install Site Recovery Manager on a different drive to the C: drive, the Site Recovery Manager installer still requires at least 1GB of free space on the C: drive. This space is required for extracting and caching the installation package. You might require more disk storage if you use the embedded database, as the content of the database grows.</td>
</tr>
<tr>
<td>Networking</td>
<td>1 Gigabit recommended for communication between Site Recovery Manager sites. Use a trusted network for the deployment and use of Site Recovery Manager and for the management of ESXi hosts.</td>
</tr>
</tbody>
</table>

For information about supported platforms and databases, see the Compatibility Matrixes for Site Recovery Manager 6.1 at [https://www.vmware.com/support/srm/srm-compat-matrix-6-1.html](https://www.vmware.com/support/srm/srm-compat-matrix-6-1.html).

- **Site Recovery Manager Licensing**
  
  After you install Site Recovery Manager, it remains in evaluation mode until you install a Site Recovery Manager license key.

- **Operational Limits of Site Recovery Manager**
  
  Each Site Recovery Manager server can support a certain number of protected virtual machines, protection groups, datastore groups, recovery plans, and concurrent recoveries.
Site Recovery Manager Licensing

After you install Site Recovery Manager, it remains in evaluation mode until you install a Site Recovery Manager license key.

After the evaluation license expires, existing protection groups remain protected and you can recover them, but you cannot create new protection groups or add virtual machines to an existing protection group until you obtain and assign a valid Site Recovery Manager license key. Obtain and assign Site Recovery Manager license keys as soon as possible after installing Site Recovery Manager.

Site Recovery Manager licenses allow you to protect a set number of virtual machines. To obtain Site Recovery Manager license keys, go to the Site Recovery Manager Product Licensing Center at http://www.vmware.com/products/site-recovery-manager/buy.html, or contact your VMware sales representative.

Site Recovery Manager License Keys and vCenter Server Instances in Linked Mode

If your vCenter Server instances are connected with vCenter Server instances in linked mode, you install the same Site Recovery Manager license on both vCenter Server instances.

Site Recovery Manager License Keys and Shared Platform Services Controller Instances

You can share an external Platform Services Controller across several vCenter Server instances. In this case, you can use the same Site Recovery Manager license on different vCenter Server instances as long as the vCenter Server instances belong to the same Platform Services Controller.

Site Recovery Manager License Keys and Protected and Recovery Sites

Site Recovery Manager requires a license key on any site on which you protect virtual machines.

- Install a Site Recovery Manager license key at the protected site to enable protection in one direction from the protected site to the recovery site.
- Install the same Site Recovery Manager license keys at both sites to enable bidirectional protection, including reprotect.

Site Recovery Manager checks for a valid license whenever you add a virtual machine to or remove a virtual machine from a protection group. If licenses are not in compliance, vSphere triggers a licensing alarm and Site Recovery Manager prevents you from protecting further virtual machines. Configure alerts for triggered licensing events so that licensing administrators receive a notification by email.
Site Recovery Manager and vCloud Suite Licensing

You can license Site Recovery Manager individually or as part of vCloud Suite. You should consider the licensing and integration options that are available to you.

When products are part of vCloud Suite, they are licensed on a per-CPU basis. You can run an unlimited number of virtual machines on CPUs that are licensed with vCloud Suite.

**Note** You cannot mix license types. For example, you cannot protect a certain number of virtual machines by using per-CPU licenses and other virtual machines by using per-VM licenses.

You can combine the features of Site Recovery Manager with other components of vCloud Suite to leverage the full capabilities of the software-defined data center. For more information, see *vCloud Suite Architecture Overview and Use Cases*.

Not all features and capabilities of vSphere are available in all editions. For a comparison of feature sets in each edition, see [http://www.vmware.com/products/vsphere/](http://www.vmware.com/products/vsphere/).

Example: Site Recovery Manager Licenses Required for Recovery and Reprotect

You have a site that contains 25 virtual machines for Site Recovery Manager to protect.

- For recovery, you require a license for at least 25 virtual machines, that you install on the protected site to allow one-way protection from the protected site to the recovery site.

- For reprotect, you require a license for at least 25 virtual machines, that you install on both the protected and the recovery site to allow bidirectional protection between the sites.

Operational Limits of Site Recovery Manager

Each Site Recovery Manager server can support a certain number of protected virtual machines, protection groups, datastore groups, recovery plans, and concurrent recoveries.

For details about the operational limits of Site Recovery Manager 6.1, see [http://kb.vmware.com/kb/2119336](http://kb.vmware.com/kb/2119336).
Creating the Site Recovery Manager Database

The Site Recovery Manager Server requires its own database, which it uses to store data such as recovery plans and inventory information.

Site Recovery Manager provides an embedded vPostgreSQL database that requires fewer steps to configure than an external database. The embedded vPostgreSQL database can support a full-scale Site Recovery Manager environment. You can select the option to use the embedded database when you install Site Recovery Manager. The Site Recovery Manager installer creates the embedded database and a database user account according to the information that you specify during installation.

You can also use an external database. If you use an external database, you must create the database and establish a database connection before you can install Site Recovery Manager.

Site Recovery Manager cannot use the vCenter Server database because it has different database schema requirements. You can use the vCenter Server database server to create and support the Site Recovery Manager database.

Each Site Recovery Manager site requires its own instance of the Site Recovery Manager database. Use a different database server instance to run the individual Site Recovery Manager databases for each site. If you use the same database server instance to run the databases for both sites, and if the database server experiences a problem, neither Site Recovery Manager site will work and you will not be able to perform a recovery.

Site Recovery Manager does not require the databases on each site to be identical. You can run different versions of a supported database from the same vendor on each site, or you can run databases from different vendors on each site. For example, you can run different versions of Oracle Server on each site, or you can have an Oracle Server database on one site and the embedded database on the other.

If you are updating Site Recovery Manager to a new version, you can use the existing database. Before you attempt an upgrade, make sure that both Site Recovery Manager Server databases are backed up. Doing so helps ensure that you can revert back to the previous version after the upgrade, if necessary.

For the list of database software that Site Recovery Manager supports, see the Compatibility Matrixes for Site Recovery Manager 6.1 at https://www.vmware.com/support/srm/srm-compat-matrix-6-1.html.

- Requirements when Using Microsoft SQL Server with Site Recovery Manager
  When you create a Microsoft SQL Server database, you must configure it correctly to support Site Recovery Manager.
Requirements when Using Oracle Server with Site Recovery Manager

When you create an Oracle Server database, you must configure it correctly to support Site Recovery Manager.

Back Up and Restore the Embedded vPostgres Database

If you select the option to use an embedded database for Site Recovery Manager, the Site Recovery Manager installer creates a vPostgres database during the installation process. You can back up and restore the embedded vPostgres database by using PostgreSQL commands.

Create an ODBC System DSN for Site Recovery Manager

You must provide Site Recovery Manager with a system database source name (DSN) for a 64-bit open database connectivity (ODBC) connector. The ODBC connector allows Site Recovery Manager to connect to the Site Recovery Manager database.

Requirements when Using Microsoft SQL Server with Site Recovery Manager

When you create a Microsoft SQL Server database, you must configure it correctly to support Site Recovery Manager.

This information provides the requirements for an SQL Server database for use with Site Recovery Manager. For specific instructions about creating an SQL Server database, see the SQL Server documentation.

Database user account:

- If you use Integrated Windows Authentication to connect to SQL Server and SQL Server runs on the same machine as Site Recovery Manager Server, use a local or domain account that has administrative privileges on the Site Recovery Manager Server machine. Use the same account or an account with the same privileges when you install Site Recovery Manager Server. When the Site Recovery Manager installer detects an SQL Server data source name (DSN) that uses Integrated Windows Authentication, it configures Site Recovery Manager Server to run under the same account as you use for the installer, to guarantee that Site Recovery Manager can connect to the database.

- If you use Integrated Windows Authentication to connect to SQL Server and SQL Server runs on a different machine from Site Recovery Manager Server, use a domain account with administrative privileges on the Site Recovery Manager Server machine. Use the same account or an account with the same privileges when you install Site Recovery Manager Server. When the Site Recovery Manager installer detects an SQL Server data source name (DSN) that uses Integrated Windows Authentication, it configures Site Recovery Manager Server to run under the same account as you use for the installer, to guarantee that Site Recovery Manager can connect to the database.

- If you use SQL authentication, you can run the Site Recovery Manager service under the Windows Local System account, even if SQL Server is running on a different machine to Site Recovery Manager Server. The Site Recovery Manager installer configures the Site Recovery Manager service to run under the Windows Local System account by default.
Make sure that the Site Recovery Manager database user account has the **ADMINISTER BULK OPERATIONS**, **CONNECT**, and **CREATE TABLE** permissions.

**Database schema:**

- The Site Recovery Manager database schema must have the same name as the database user account.
- The Site Recovery Manager database user must be the owner of the Site Recovery Manager database schema.
- The Site Recovery Manager database schema must be the default schema for the Site Recovery Manager database user.

The Site Recovery Manager database must be the default database for all SQL connections that Site Recovery Manager makes. You can set the default database either in the user account configuration in SQL Server or in the DSN.

- Map the database user account to the database login.


### Requirements for Using Oracle Server with Site Recovery Manager

When you create an Oracle Server database, you must configure it correctly to support Site Recovery Manager.

You create and configure an Oracle Server database for Site Recovery Manager by using the tools that Oracle Server provides.

This information provides the general steps that you must perform to configure an Oracle Server database for Site Recovery Manager. For instructions about how to perform the relevant steps, see the Oracle documentation.

- When creating the database instance, specify UTF-8 encoding.
- Grant the Site Recovery Manager database user account the **connect**, **resource**, **create session** privileges and permissions.

Back Up and Restore the Embedded vPostgres Database

If you select the option to use an embedded database for Site Recovery Manager, the Site Recovery Manager installer creates a vPostgres database during the installation process. You can back up and restore the embedded vPostgres database by using PostgreSQL commands.

Always back up the Site Recovery Manager database before updating or upgrading Site Recovery Manager. You also might need to back up and restore the embedded vPostgres database if you need to uninstall then reinstall Site Recovery Manager and retain data from the previous installation, migrate Site Recovery Manager Server to another host machine, or revert the database to a clean state in the event that it becomes corrupted.

Prerequisites

For information about the commands that you use to back up and restore the embedded vPostgres database, see the pg_dump and pg_restore commands in the PostgreSQL documentation at http://www.postgresql.org/docs/9.3/static/index.html.

Procedure

1. Log into the system on which you installed Site Recovery Manager Server.
2. Stop the Site Recovery Manager service.
3. Navigate to the folder that contains the vPostgres commands.
   
   If you installed Site Recovery Manager Server in the default location, you find the vPostgres commands in C:\Program Files\VMware\VMware vCenter Site Recovery Manager Embedded Database\bin.

4. Create a backup of the embedded vPostgres database by using the pg_dump command.

   ```bash
   pg_dump -Fc --host 127.0.0.1 --port port_number --username=db_username srm_db > srm_backup_name
   ```

   You set the port number, username, and password for the embedded vPostgres database when you installed Site Recovery Manager. The default port number is 5678. The database name is srm_db and cannot be changed.

5. Perform the actions that necessitate the backup of the embedded vPostgres database.

   For example, update or upgrade Site Recovery Manager, uninstall and reinstall Site Recovery Manager, or migrate Site Recovery Manager Server.

6. (Optional) Restore the database from the backup that you created in Step 4 by using the pg_restore command.

   ```bash
   pg_restore -Fc --host 127.0.0.1 --port port_number --username=db_username --dbname=srm_db srm_backup_name
   ```

7. Start the Site Recovery Manager service.
Create an ODBC System DSN for Site Recovery Manager

You must provide Site Recovery Manager with a system database source name (DSN) for a 64-bit open database connectivity (ODBC) connector. The ODBC connector allows Site Recovery Manager to connect to the Site Recovery Manager database.

You can create the ODBC system DSN before you run the Site Recovery Manager installer by running Odbcad32.exe, the 64-bit Windows ODBC Administrator tool.

Alternatively, you can create an ODBC system DSN by running the Windows ODBC Administrator tool during the Site Recovery Manager installation process.

**Note** If you use the embedded Site Recovery Manager database, the Site Recovery Manager installer creates the ODBC system DSN according to the information that you provide during installation. If you uninstall the embedded database, the uninstaller does not remove the DSN for the embedded database. The DSN remains available for use with a future reinstallation of Site Recovery Manager.

**Prerequisites**

You created the database instance to connect to Site Recovery Manager.

**Procedure**

1. Double-click the Odbcad32.exe file at C:\Windows\System32 to open the 64-bit ODBC Administrator tool.

   **Important** Do not confuse the 64-bit Windows ODBC Administrator tool with the 32-bit ODBC Administrator tool located in C:\Windows\SysWOW64. Do not use the 32-bit ODBC Administrator tool.

2. Click the System DSN tab and click Add.

3. Select the appropriate ODBC driver for your database software and click Finish.

<table>
<thead>
<tr>
<th>Option</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>SQL Server</td>
<td>Select SQL Server Native Client 10.0, SQL Server Native Client 11.0, or ODBC Driver 11 for SQL Server.</td>
</tr>
<tr>
<td>Oracle Server</td>
<td>Select Microsoft ODBC for Oracle.</td>
</tr>
</tbody>
</table>
4 (Optional) Create an SQL Server data source for the database.
   a. Provide the details for the data source.

<table>
<thead>
<tr>
<th>Option</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Enter a name for this data source, for example SRM.</td>
</tr>
<tr>
<td>Description</td>
<td>Enter a description of the data source, for example SRM.</td>
</tr>
<tr>
<td>Server</td>
<td>Select the running database instance to which to connect or enter the address of the database server.</td>
</tr>
</tbody>
</table>

   b. Select the authentication method that corresponds to the type of database user account that you created and click Next.

   If you select Integrated Windows Authentication, you must use the same user account, or an account with the same privileges on the Site Recovery Manager Server host machine, when you run the Site Recovery Manager.

   c. Select the Change the default database to check box and select the Site Recovery Manager database.

   d. Click Next to retain the default settings for this database connection and click Finish.

5 (Optional) Create an Oracle Server data source for the database and click Next.

<table>
<thead>
<tr>
<th>Option</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>Data Source Name</td>
<td>Enter a name for this data source, for example SRM.</td>
</tr>
<tr>
<td>Description</td>
<td>Enter a description of the data source, for example SRM.</td>
</tr>
<tr>
<td>TNS Service Name</td>
<td>Enter the address of the database server in the format database_server_address:1521/database_name.</td>
</tr>
<tr>
<td>User ID</td>
<td>Enter the database user name.</td>
</tr>
</tbody>
</table>

6 Click Test Data Source to test the connection and click OK if the test succeeds.

If the test does not succeed, check the configuration information and try again.

7 Click OK to exit the Windows ODBC Administrator tool.

The ODBC driver for your database is ready to use.
Site Recovery Manager Authentication

The Platform Services Controller handles the authentication between Site Recovery Manager and vCenter Server at the vCenter Single Sign-On level.

All communications between Site Recovery Manager and vCenter Server instances take place over transport layer security (TLS) connections. Previous versions of Site Recovery Manager supported both secure sockets layer (SSL) and TLS connections. This version of Site Recovery Manager only supports TLS, due to weaknesses identified in SSL 3.0.

Solution User Authentication

In Site Recovery Manager 5.x, you used either credential-based authentication or certificate-based authentication to authenticate with vCenter Server. Site Recovery Manager 6.x uses solution user authentication to establish secure communication to remote services, such as the Platform Services Controller and vCenter Server. A solution user is a security principal that the Site Recovery Manager installer generates. The installer assigns a private key and a certificate to the solution user and registers it with the vCenter Single Sign-On service. The solution user is tied to a specific Site Recovery Manager instance. You cannot access the solution user private key or certificate. You cannot replace the solution user certificate with a custom certificate.

After installation, you can see the Site Recovery Manager solution user in the Administration view of the vSphere Web Client. Do not attempt to manipulate the Site Recovery Manager solution user. The solution user is for internal use by Site Recovery Manager, vCenter Server, and vCenter Single Sign-On.

During operation, Site Recovery Manager establishes authenticated communication channels to remote services by using certificate-based authentication to acquire a holder-of-key SAML token from vCenter Single Sign-On. Site Recovery Manager sends this token in a cryptographically signed request to the remote service. The remote service validates the token and establishes the identity of the solution user.

Solution Users and Site Recovery Manager Site Pairing

When you pair Site Recovery Manager instances across vCenter Single Sign-On sites that do not use Enhanced Linked Mode, Site Recovery Manager creates an additional solution user for the remote site at each site. This solution user for the remote site allows the Site Recovery Manager Server at the remote site to authenticate to services on the local site.
When you pair Site Recovery Manager instances in a vCenter Single Sign-On environment with Enhanced Linked Mode, Site Recovery Manager at the remote site uses the same solution user to authenticate to services on the local site.

**Site Recovery Manager SSL/TLS Server Endpoint Certificates**

Site Recovery Manager requires an SSL/TLS certificate for use as the endpoint certificate for all TLS connections established to Site Recovery Manager. The Site Recovery Manager server endpoint certificate is separate and distinct from the certificate that is generated during the creation and registration of a Site Recovery Manager solution user.

For information about the Site Recovery Manager SSL/TLS endpoint certificate, see Chapter 5 Creating SSL/TLS Server Endpoint Certificates for Site Recovery Manager.
Creating SSL/TLS Server Endpoint Certificates for Site Recovery Manager

The Site Recovery Manager server endpoint certificate establishes the identity of Site Recovery Manager Server to clients. The endpoint certificate secures the communication between the client and Site Recovery Manager Server.

During installation of Site Recovery Manager, there is an option for Site Recovery Manager to generate an SSL/TLS certificate to use as the Site Recovery Manager endpoint certificate. This is the simpler option that requires minimal user action.

You can also provide a custom SSL/TLS certificate that is signed by a certificate authority. If you use a custom SSL/TLS certificate, the certificate must meet certain requirements to work with Site Recovery Manager.

*Note* Unlike in 5.x releases, Site Recovery Manager 6.x does not also use custom SSL/TLS certificates to authenticate with vCenter Server. For information about how Site Recovery Manager authenticates with vCenter Server, see Chapter 4 Site Recovery Manager Authentication.

Requirements When Using Custom SSL/TLS Certificates with Site Recovery Manager

If you use custom SSL/TLS certificates for the Site Recovery Manager server endpoint certificate, the certificates must meet specific criteria.

*Important* Public certificate authorities (CAs) stopped issuing SSL/TLS certificates that contain internal server names or reserved IP addresses in November 2015. CAs will revoke SSL/TLS certificates that contain internal server names or reserved IP addresses on 1st October 2016. To minimize future disruption, if you use SSL/TLS certificates that contain internal server names or reserved IP addresses, obtain new, compliant certificates from your public CA before 1st October 2016. Alternatively, use a private CA to issue certificates.

- For information about the deprecation of internal server names and reserved IP addresses, see https://cabforum.org/internal-names/.
- For information about how the deprecation of internal server names and reserved IP addresses affects VMware products, see http://kb.vmware.com/kb/2134735.
Site Recovery Manager 6.x uses standard PKCS#12 certificates. Site Recovery Manager places some requirements on the contents of those certificates, but the requirements in this release are less strict than in 5.x releases of Site Recovery Manager.

- Site Recovery Manager does not accept certificates with MD5 signature algorithms. Use SHA256 or stronger signature algorithms.
- Site Recovery Manager accepts certificates with SHA1 signature algorithms but these are not recommended and result in a warning during installation. Use SHA256 or stronger signature algorithms.
- The Site Recovery Manager certificate is not the root of a trust chain. You can use an intermediate CA certificate which is not the root of a trust chain, but that is still a CA certificate.
- If you use a custom certificate for vCenter Server and Platform Services Controller, you are not obliged to use a custom certificate for Site Recovery Manager. The reverse is also true.
- The private key in the PKCS #12 file must match the certificate. The minimum length of the private key is 2048 bits.
- The Site Recovery Manager certificate password must not exceed 31 characters.
- The current time must be within the period of validity of the certificate.
- The certificate must be a server certificate, for which the x509v3 Extended Key Usage must indicate TLS Web Server Authentication.
  - The certificate must include an extendedKeyUsage or enhancedKeyUsage attribute, the value of which is serverAuth.
  - Unlike in 5.x releases, there is no requirement for the certificate to also be a client certificate. The clientAuth value is not required.
- The Subject Name must not be empty and must contain fewer than 4096 characters. In this release, the Subject Name does not need to be the same for both members of a Site Recovery Manager Server pair.
- The certificate must identify the Site Recovery Manager Server host.
  - The recommended way to identify the Site Recovery Manager Server host is with the host's fully-qualified domain name (FQDN). If the certificate identifies the Site Recovery Manager Server host with an IP address, this must be an IPv4 address. Using IPv6 addresses to identify the host is not supported.
  - Certificates generally identify the host in the Subject Alternative Name (SAN) attribute. Some CAs issue certificates that identify the host in the Common Name (CN) value of the Subject Name attribute. Site Recovery Manager accepts certificates that identify the host in the CN value, but this is not the best practice. For information about SAN and CN best practices, see the Internet Engineering Task Force (IETF) RFC 6125 at https://tools.ietf.org/html/rfc6125.
  - The host identifier in the certificate must match the Site Recovery Manager Server local host address that you specify when you install Site Recovery Manager.
If Site Recovery Manager Server, vCenter Server, and Platform Services Controller run on the same host machine, you can use the same certificate for all three servers. In this case, you must provide the certificate in two formats:

- For Site Recovery Manager, the certificate must be a Personal Information Exchange Format (PKCS#12) certificate that contains both of the private and public keys.
- For vCenter Server and Platform Services Controller, the certificate must be separated into two files, one for the certificate with the public key and one for the private key. For information about certificate requirements for vCenter Server and Platform Services Controller, see *vSphere Security Certificates* in the vSphere 6.0 documentation.

If you use a custom certificate that is signed by a third-party CA for which the root certificate is not registered by default in Windows, and you want the certificates to be trusted without the need for thumbprint verifications, install the root CA certificate in the Windows certificate store.
Installing Site Recovery Manager

You must install a Site Recovery Manager Server instance at the protected site and also at the recovery site.

Site Recovery Manager requires a vCenter Server instance of the appropriate version at each site before you install Site Recovery Manager Server. The Site Recovery Manager installer must be able to connect to this vCenter Server instance during installation. For information about compatibility between vCenter Server and Site Recovery Manager versions, see vCenter Server Requirements in the Compatibility Matrixes for Site Recovery Manager 6.1 at https://www.vmware.com/support/srm/srm-compat-matrix-6-1.html.

After you install the Site Recovery Manager Server instances, the Site Recovery Manager plug-in appears in the vSphere Web Client. You use the Site Recovery Manager plug-in in the vSphere Web Client for the vCenter Server instances on the protected and recovery sites to configure and manage Site Recovery Manager. Site Recovery Manager 6.1 does not support the vSphere Client for Windows.

Procedure

1 Site Recovery Manager and vCenter Server Deployment Models
   You can install Site Recovery Manager in any of the deployment models that vCenter Server supports. However, the vCenter Server deployment model that you select can have implications for Site Recovery Manager operation.

2 Prerequisites and Best Practices for Site Recovery Manager Server Installation
   Before you install Site Recovery Manager Server, you must perform several tasks and verify that you have certain information.

3 Install Site Recovery Manager Server
   You must install Site Recovery Manager Server at the protected site and at the recovery site.

4 Connect the Site Recovery Manager Server Instances on the Protected and Recovery Sites
   Before you can use Site Recovery Manager, you must connect the Site Recovery Manager Server instances on the protected and recovery sites. This is known as site pairing.

5 Establish a Client Connection to the Remote Site Recovery Manager Server Instance
   After you connect the Site Recovery Manager Server instances, you must establish a connection from the Site Recovery Manager interface in the vSphere Web Client to the remote Site Recovery Manager Server.
6 **Install the Site Recovery Manager License Key**

Site Recovery Manager Server requires a license key to operate. Install a Site Recovery Manager license key as soon as possible after you install Site Recovery Manager.

7 **Site Recovery Manager Server Does Not Start**

Site Recovery Manager depends on other services. If one of those services is not running, the Site Recovery Manager Server does not start.

8 **Unregister an Incompatible Version of vSphere Replication**

Site Recovery Manager requires the corresponding version of vSphere Replication. The Site Recovery Manager installer verifies the version of vSphere Replication and stops if it detects an incompatible version.

**Site Recovery Manager and vCenter Server Deployment Models**

You can install Site Recovery Manager in any of the deployment models that vCenter Server supports. However, the vCenter Server deployment model that you select can have implications for Site Recovery Manager operation.

You deploy vCenter Server with a Platform Services Controller. You can either embed the Platform Services Controller with vCenter Server or it can be external to vCenter Server. Several vCenter Server instances can share the same external Platform Services Controller.

You can deploy the Platform Services Controller in several different configurations.

- Each Platform Services Controller can have its own vCenter Single Sign-On domain.
- Several Platform Services Controller instances can join the same vCenter Single Sign-On domain.
- You can configure vCenter Single Sign-On domains in Enhanced Linked Mode, which federates all of the Platform Services Controller instances from each of the linked domains.

For information about the deployment models that vCenter Server supports, see vCenter Server Deployment Models in *vSphere Installation and Setup*.

You must take the deployment model of vCenter Server and Platform Services Controller into consideration when you install Site Recovery Manager. During a disaster recovery, Site Recovery Manager, vCenter Server, and the associated Platform Services Controller must be up and running on the recovery site.

**Configuring the Platform Services Controller and Selecting the Correct vCenter Server Instance in an Enhanced Linked Mode Environment**

When you install Site Recovery Manager Server, you provide the address of the Platform Services Controller that is associated with the vCenter Server instance to protect. You then select the vCenter Server instance with which to register Site Recovery Manager from the list of all of the vCenter Server instances that this Platform Services Controller serves. In an Enhanced Linked Mode
environment, that list might include vCenter Server instances from other sites. If you select the wrong vCenter Server instance and complete the Site Recovery Manager installation, you cannot subsequently modify the Site Recovery Manager installation to select the correct vCenter Server instance. In this case, you must uninstall and reinstall Site Recovery Manager to select the correct vCenter Server instance.

- When you install Site Recovery Manager Server on the protected site, make sure that you select the vCenter Server instance that manages the virtual machines to protect.

- When you install Site Recovery Manager Server on the recovery site, make sure that you select the vCenter Server instance to which to recover virtual machines.

- Ensure that the Platform Services Controller, vCenter Server, and Site Recovery Manager Server are all located on the protected site, or all on the recovery site.

After you have installed Site Recovery Manager, if vCenter Server migrates to a different Platform Services Controller or if the address of the Platform Services Controller changes, you can reconfigure Site Recovery Manager with the new Platform Services Controller address. For example, you can change from an embedded Platform Services Controller to an external Platform Services Controller. For information about changing Platform Services Controller, see Reconfigure vCenter Server with Embedded Platform Services Controller to vCenter Server with External Platform Services Controller in vSphere Installation and Setup.

You change the Platform Services Controller address by running the Site Recovery Manager installer in Modify mode.

Sharing Platform Services Controller Instances Across Site Recovery Manager Sites

A single point of failure is created if you share a Platform Services Controller instance between the protected and recovery sites. If the shared Platform Services Controller goes offline, neither the protected site nor the recovery site will function, making recovery impossible.

Concurrent Installations of Site Recovery Manager in an Enhanced Linked Mode Environment

In an Enhanced Linked Mode environment, do not install Site Recovery Manager under more than one Platform Services Controller at the same time. A conflict can arise in the creation of the solution user that Platform Services Controller creates at the domain level for Site Recovery Manager authentication with vCenter Server if the following conditions exist:

- If the installation of one Site Recovery Manager Server instance overlaps with the installation of another Site Recovery Manager Server instance under two different Platform Services Controller instances.

- Those Platform Services Controller instances are in Enhanced Linked Mode.
The conflict does not prevent installation, but it does cause one of the Site Recovery Manager Server instances to fail to start, with the error message Failed to start service. The message Failed to start Authorization Manager appears in the event log for that Site Recovery Manager Server instance.

**Site Recovery Manager in a Two-Site Topology with One vCenter Server Instance per Platform Services Controller**

The most common deployment for Site Recovery Manager is to have two sites with one vCenter Server instance per Platform Services Controller.

In this configuration, the Platform Services Controller instances can be either external to vCenter Server or embedded in the vCenter Server instances.

The Platform Services Controller instances can belong to vCenter Single Sign-On domains that are either in Enhanced Linked Mode or are not in Enhanced Linked Mode.

**Figure 6-1. Site Recovery Manager in a Two-Site Topology with One vCenter Server Instance per Platform Services Controller**
Site Recovery Manager in a Two-Site Topology with Multiple vCenter Server Instances per Platform Services Controller

You can deploy Site Recovery Manager in a topology in which multiple vCenter Server instances share a Platform Services Controller on each site.

In this configuration, the Platform Services Controller instances are external to the vCenter Server instances.

The Platform Services Controller instances can belong to vCenter Single Sign-On domains that are either in Enhanced Linked Mode or are not in Enhanced Linked Mode.

**Figure 6-2. Site Recovery Manager in a Two-Site Topology with Two vCenter Server Instances per Platform Services Controller**

Key:
- **Site Recovery Manager site pair**
- **Connection from Site Recovery Manager to Platform Services Controller**
- **Connection from Platform Services Controller to vCenter Server**
Site Recovery Manager in a Single Site Topology with a Shared Platform Services Controller

You can deploy Site Recovery Manager Server so that both instances connect to vCenter Server instances that share a Platform Services Controller.

In this configuration, both vCenter Server instances connect to the same Platform Services Controller within a single site.

**Important** When the vCenter Server instances on the protected and recovery sites share the same Platform Services Controller, the Platform Services Controller becomes a single point of failure. If the Platform Services Controller goes offline, neither of the protected and recovery sites can function, and recovery is impossible. This configuration is not appropriate for disaster recovery, and is not recommended.

Figure 6-3. Site Recovery Manager in a Single Site Topology with a Shared Platform Services Controller
Prerequisites and Best Practices for Site Recovery Manager Server Installation

Before you install Site Recovery Manager Server, you must perform several tasks and verify that you have certain information.

- Install the appropriate version of Platform Services Controller and vCenter Server on both sites. You cannot mix Site Recovery Manager, Platform Services Controller, or vCenter Server versions across sites. For information about compatibility between vCenter Server and Site Recovery Manager versions, see vCenter Server Requirements in the Compatibility Matrixes for Site Recovery Manager 6.1 at https://www.vmware.com/support/srm/srm-compat-matrix-6-1.html.

- For environments with a small number of virtual machines to protect, you can run Site Recovery Manager Server and vCenter Server on the same system. For environments that approach the maximum limits of Site Recovery Manager and vCenter Server, install Site Recovery Manager Server on a system that is different from the system on which vCenter Server is installed. If Site Recovery Manager Server and vCenter Server are installed on the same system, administrative tasks might become more difficult to perform in large environments. Furthermore, if you install Site Recovery Manager Server in a virtual machine, and this virtual machine is not the same as the one that runs vCenter Server, you can use vSphere High Availability and VMware Fault Tolerance to protect the Site Recovery Manager Server virtual machine.

- When you install and configure Platform Services Controller, vCenter Server, and vSphere Replication, use fully qualified domain names (FQDN) whenever possible rather than IP addresses. Using FQDN rather than IP addresses allows you to change the vSphere infrastructure, for example by using DHCP, without having to redeploy or reconfigure Site Recovery Manager. You must also use FQDN if you use custom certificates, because most certificate authorities do not accept certificates that use IP addresses for the SAN or CN value.

- The way in which you deploy Platform Services Controller, vCenter Server, and vCenter Single Sign-On on a site affects how you deploy Site Recovery Manager. For information about how the vCenter Server deployment model affects Site Recovery Manager, see Site Recovery Manager and vCenter Server Deployment Models.

- Obtain the address of the Platform Services Controller instance for both sites. The Platform Services Controller must be running and accessible during Site Recovery Manager installation.

- Obtain the vCenter Single Sign-On administrator user name and password for both of the local and remote sites.
Synchronize the clock settings of the systems on which Platform Services Controller, vCenter Server, and Site Recovery Manager Server run. To avoid conflicts in the time management across these systems, use a persistent synchronization agent such as network time protocol daemon (NTPD), W32Time, or VMware Tools time synchronization. If you run Platform Services Controller, vCenter Server, and Site Recovery Manager Server in virtual machines, set up NTP time synchronization on the ESXi host on which the virtual machines run. For information about timekeeping best practices, see http://kb.vmware.com/kb/1318.

Obtain a Windows user account with the appropriate privileges on the system on which to install and run Site Recovery Manager Server. You can configure the Site Recovery Manager service to run under a specified user account. The account can be a local user or a domain user that is a member of the Administrators group on the machine on which you are installing Site Recovery Manager. Alternatively, you can configure Site Recovery Manager to run under the Local System account during installation.

Obtain the user name and password for the Site Recovery Manager database, if you are not using the embedded database.

If you do not use the embedded Site Recovery Manager database, configure and start the Site Recovery Manager database service on both sites before you install the Site Recovery Manager Server. Each Site Recovery Manager instance requires its own database. See Chapter 3 Creating the Site Recovery Manager Database.

If you do not use the embedded Site Recovery Manager database, Site Recovery Manager requires a database source name (DSN) for 64-bit open database connectivity (ODBC). You can create the ODBC system DSN before you run the Site Recovery Manager installer, or you can create the DSN during the installation process. For details about creating the ODBC system DSN, see Create an ODBC System DSN for Site Recovery Manager. If you use the embedded Site Recovery Manager database, the Site Recovery Manager installer creates the necessary DSN.

To use Site Recovery Manager with vSphere Replication, deploy the appropriate version of vSphere Replication on both of the protected and recovery sites before you install Site Recovery Manager Server. The Site Recovery Manager installer verifies the version of vSphere Replication during installation and stops if it detects an incompatible version. This verification is not performed if you install vSphere Replication after you install Site Recovery Manager Server, which might lead to incompatible versions. Incompatible versions of Site Recovery Manager and vSphere Replication cause the vSphere Web Client to stop working. For information about compatibility between vSphere Replication and Site Recovery Manager versions, see vSphere Replication Requirements in the Compatibility Matrixes for Site Recovery Manager 6.1 at https://www.vmware.com/support/srm/srm-compat-matrix-6-1.html.

If you cannot upgrade an existing incompatible version of vSphere Replication, you must unregister vSphere Replication from both vCenter Server instances before you install Site Recovery Manager. Incompatible versions of Site Recovery Manager and vSphere Replication cause the vSphere Web Client to stop working. See Unregister an Incompatible Version of vSphere Replication.
The Site Recovery Manager installer presents the SSL/TLS certificate of the Platform Services Controller for validation when it runs. Obtain the necessary information to allow you to validate the certificate.

If you use custom certificates, obtain an appropriate certificate file. See Requirements When Using Custom SSL/TLS Certificates with Site Recovery Manager.

Download the Site Recovery Manager installation file to a folder on the machine on which to install Site Recovery Manager.

Verify that no reboot is pending on the Windows machine on which to install Site Recovery Manager Server. Verify that no other installation is running, including the silent installation of Windows updates. Pending reboots or running installations can cause the installation of Site Recovery Manager Server or the embedded Site Recovery Manager database to fail.

Optimize the Adobe Flash Player settings in your browser to increase the amount of storage space that the vSphere Web Client can use. Performing a recovery with Site Recovery Manager can sometimes exceed the default amount of storage space that Flash Player is permitted to consume. For information about how to optimize the Flash Player settings for Site Recovery Manager in the vSphere Web Client, see http://kb.vmware.com/kb/2106096.

Install Site Recovery Manager Server

You must install Site Recovery Manager Server at the protected site and at the recovery site.

If you are upgrading an existing Site Recovery Manager installation, see Chapter 8 Upgrading Site Recovery Manager.

If you are installing Site Recovery Manager in a shared recovery site configuration, see Chapter 9 Installing Site Recovery Manager to Use with a Shared Recovery Site.

Prerequisites

Perform the tasks and verify that you have the required information listed in Prerequisites and Best Practices for Site Recovery Manager Server Installation.

If you use an SQL Server database with Integrated Windows Authentication as the Site Recovery Manager database, you must use the same user account or an account with the same privileges when you install Site Recovery Manager Server as you used when you created the Integrated Windows Authentication data source name (DSN) for SQL Server.

Procedure

1. Double-click the Site Recovery Manager installer, select an installation language, and click OK.

2. Follow the installer prompts to accept the license agreement, and verify that you satisfied the installation prerequisites.
3 Choose where to install Site Recovery Manager Server, and click **Next**.

- Keep the default destination folder.
- Click **Change** to change the destination folder, and select a target volume.

The default installation folder for Site Recovery Manager is `C:\Program Files\VMware\VMware vCenter Site Recovery Manager`. If you use a different folder, the pathname cannot be longer than 120 characters including the end slash, and cannot include non-ASCII characters.

4 Enter information about the Platform Services Controller at the site where you are installing Site Recovery Manager and click **Next**.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Address</strong></td>
<td>The host name or IP address of the Platform Services Controller for the vCenter Server with which to register Site Recovery Manager. Enter the host name in lowercase letters. After installation is complete and you are configuring the connection between the protected and recovery sites, supply this host name or IP address exactly as you enter it here, because it is subject to case-sensitive comparisons.</td>
</tr>
<tr>
<td><strong>Important</strong></td>
<td>To facilitate IP address changes in your infrastructure, provide a fully qualified domain name (FQDN) whenever possible, rather than an IP address.</td>
</tr>
<tr>
<td><strong>Important</strong></td>
<td>If the Platform Services Controller uses an FQDN rather than an IP address, you must specify the FQDN when you install Site Recovery Manager.</td>
</tr>
<tr>
<td><strong>HTTPS Port</strong></td>
<td>Accept the default value of 443 or enter a new value if Platform Services Controller uses a different port. Platform Services Controller only supports connections over HTTPS and does not support HTTP connections.</td>
</tr>
<tr>
<td><strong>Username</strong></td>
<td>The vCenter Single Sign-On user name for the vCenter Single Sign-On domain to which this Platform Services Controller instance belongs. This user account must be a member of the vCenter Single Sign-On Administrator group on the Platform Services Controller instance. Only members of the Administrator group have the necessary permissions to create or recreate the Site Recovery Manager solution user.</td>
</tr>
<tr>
<td><strong>Password</strong></td>
<td>The password for the specified vCenter Single Sign-On user name. The password text box can be empty.</td>
</tr>
</tbody>
</table>

5 If prompted, verify the Platform Services Controller certificate and click **Accept** to accept it.

6 Select the vCenter Server instance with which to register Site Recovery Manager and click **Next**.

**Important** The drop-down menu includes all of the vCenter Server instances that are registered with the Platform Services Controller. In an environment that uses Enhanced Linked Mode, it can also include vCenter Server instances from other Platform Services Controller instances. Make sure that you select the correct vCenter Server instance. Once the Site Recovery Manager installation is complete, you cannot modify it to select a different vCenter Server instance.
7 Enter information with which to register the Site Recovery Manager extension with vCenter Server, and click **Next**.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Local Site Name</td>
<td>A name for this Site Recovery Manager site, that appears in the Site Recovery Manager interface. The vCenter Server address is used by default, but you can enter any name. You cannot use the same name that you use for another Site Recovery Manager installation with which this one will be paired.</td>
</tr>
<tr>
<td>Administrator E-mail</td>
<td>Email address of the Site Recovery Manager administrator. This information is required even though you use the standard vCenter Server alarms to configure email notifications for Site Recovery Manager events.</td>
</tr>
<tr>
<td>Local Host</td>
<td>Name or IP address of the local host. The Site Recovery Manager installer obtains this value. Only change it if it is incorrect. For example, the local host might have more than one network interface and the one that the Site Recovery Manager installer detects is not the interface you want to use.</td>
</tr>
<tr>
<td>Important</td>
<td>To facilitate IP address changes in your infrastructure, provide a fully qualified domain name (FQDN) whenever possible, rather than an IP address.</td>
</tr>
<tr>
<td>Listener Port</td>
<td>HTTPS port for all management traffic to Site Recovery Manager Server, including traffic with external API clients for task automation. The port is also used by vSphere Web Client to download the Site Recovery Manager client plugin. This port must be accessible from the vCenter Server proxy system. Do not change the port unless the default of 9086 causes port conflicts.</td>
</tr>
</tbody>
</table>

8 Select the default Site Recovery Manager plug-in identifier, or create a plug-in identifier for this Site Recovery Manager Server pair, and click **Next**.

Both Site Recovery Manager Server instances in a site pair must use the same plug-in identifier.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Default SRM Plug-in Identifier</td>
<td>Use this option when you install Site Recovery Manager in a standard configuration with one protected site and one recovery site.</td>
</tr>
<tr>
<td>Custom SRM Plug-in Identifier</td>
<td>Use this option when you install Site Recovery Manager in a shared recovery site configuration, with multiple protected sites and one recovery site. Enter the details of the plug-in identifier.</td>
</tr>
<tr>
<td>Plug-in ID</td>
<td>A unique identifier. Assign the same identifier to the Site Recovery Manager Server instances on the protected site and the shared recovery site.</td>
</tr>
<tr>
<td>Organization</td>
<td>The name of the organization to which this Site Recovery Manager Server pair belongs. This name helps to identify to Site Recovery Manager Server pairs in a shared recovery site configuration, especially when multiple organizations use the shared recovery site.</td>
</tr>
<tr>
<td>Description</td>
<td>An optional description of this Site Recovery Manager Server pair.</td>
</tr>
</tbody>
</table>
9  Select a certificate type and click **Next**.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Automatically generate certificate</strong></td>
<td>Use an automatically generated certificate:</td>
</tr>
<tr>
<td>a Select <strong>Automatically generate certificate</strong> and click <strong>Next</strong>.</td>
<td>b Enter text values for your organization and organization unit, typically your company name and the name of your group in the company.</td>
</tr>
<tr>
<td>c Click <strong>Next</strong>.</td>
<td></td>
</tr>
<tr>
<td><strong>Load a certificate file</strong></td>
<td>Use a custom certificate:</td>
</tr>
<tr>
<td>a Select <strong>Use a PKCS#12 certificate file</strong> and click <strong>Next</strong>.</td>
<td>b Click <strong>Browse</strong>, navigate to the certificate file, and click <strong>Open</strong>. The certificate file must contain exactly one certificate with exactly one private key matching the certificate.</td>
</tr>
<tr>
<td>c Enter the certificate password.</td>
<td>d Click <strong>Next</strong>.</td>
</tr>
</tbody>
</table>

10 Select whether to use the embedded database or a custom database, and click **Next**.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Use the embedded database server</strong></td>
<td>Site Recovery Manager provides a built-in vPostgres database that you can use with minimal configuration.</td>
</tr>
<tr>
<td><strong>Use a custom database server</strong></td>
<td>Select an existing 64-bit DSN from the drop-down menu. You can also click <strong>DSN Setup</strong> to start the Windows 64-bit ODBC Administrator tool, to view the existing DSNs, or to create a new 64-bit system DSN for the Site Recovery Manager database.</td>
</tr>
</tbody>
</table>

11 Provide the Site Recovery Manager database configuration information and click **Next**.

<table>
<thead>
<tr>
<th>Option</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Data Source Name</strong></td>
<td>This option is only visible if you selected <strong>Use the embedded database server</strong>. Enter a name for the DSN that the Site Recovery Manager installer creates when it creates the embedded database. The embedded database DSN can only contain alphanumeric characters and underscores.</td>
</tr>
<tr>
<td><strong>Database Username</strong></td>
<td>- Enter a user name for the database user account that the Site Recovery Manager installer creates when it creates the embedded database. The embedded database username can only contain lower case alphanumeric characters and underscores.</td>
</tr>
<tr>
<td></td>
<td>- Enter the user name for an existing database user account to use with a custom database. This option is disabled if you use SQL Server with Integrated Windows Authentication. In this case, the credentials of the user account running the Site Recovery Manager installer are used to authenticate with SQL Server. This account is also used to run the Site Recovery Manager service, to guarantee that Site Recovery Manager can connect to the database.</td>
</tr>
<tr>
<td>Option</td>
<td>Action</td>
</tr>
<tr>
<td>---------------------</td>
<td>--------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
</tbody>
</table>
| Database Password   | ■ Enter a password for the database user account that the Site Recovery Manager installer creates when it creates the embedded database. The password cannot contain any white spaces, quotation marks, backslashes, or Extended ASCII characters.  
  ■ Enter the password for an existing database user account to use with a custom database. This option is disabled if you use SQL Server with Integrated Windows Authentication. |
| Database Port       | This option is only visible if you selected **Use the embedded database server**. You cannot change this value if the embedded database already exists.                                                                 |
| Connection Count    | Enter the initial connection pool size. If all connections are in use and a new one is needed, a connection is created as long as it does not exceed the maximum number of connections allowed. It is faster for Site Recovery Manager to use a connection from the pool than to create one. The maximum value that you can set depends on your database configuration. In most cases, it is not necessary to change this setting. Before changing this setting, consult with your database administrator. Setting the value too high can lead to database errors. |
| Max Connections     | Enter the maximum number of database connections that can be open simultaneously. The maximum value that you can set depends on your database configuration. If the database administrator restricted the number of connections that the database can have open, this value cannot exceed that number. In most cases, it is not necessary to change this setting. Before you change this setting, consult with your database administrator. Setting the value too high can lead to database errors. |

12 Select the user account under which to run the Site Recovery Manager Server service and click **Next**.

- Select **Use Local System Account** to run the Site Recovery Manager Server service under the Local System account.
- Enter the username and password of an existing LDAP user account to run the Site Recovery Manager Server service under a different user account. This can be any user account, including local users, that is a member of the built-in Administrators group.

This option is not available if you use an SQL Server database with Integrated Windows Authentication. In this case, the Site Recovery Manager Server service runs under the account that you use to install Site Recovery Manager.

13 Click **Install**.

14 When the installation is finished, click **Finish**.

15 Repeat steps **Step 1** through **Step 14** on the other site.
Connect the Site Recovery Manager Server Instances on the Protected and Recovery Sites

Before you can use Site Recovery Manager, you must connect the Site Recovery Manager Server instances on the protected and recovery sites. This is known as site pairing.

Prerequisites

- Verify that you installed Site Recovery Manager Server instances at the protected and recovery sites.
- If you did not select the default plug-in ID when you installed Site Recovery Manager Server, you must have assigned the same custom plug-in ID to the Site Recovery Manager Server instances on each of the sites.

Procedure

1. Connect to vSphere Web Client on one of the sites, and select Site Recovery > Sites.
2. Right-click a site and select Pair Site.
3. Enter the address of the Platform Services Controller for the Site Recovery Manager Server on the remote site, and click Next.
   
   The address that you provide for the Platform Services Controller must be an exact match of the of address that you provided when you installed Site Recovery Manager Server on the remote site.

   **Important** To facilitate IP address changes in your infrastructure, provide a fully qualified domain name (FQDN) whenever possible, rather than an IP address.

4. Select the vCenter Server instance with which Site Recovery Manager Server is registered on the remote site, provide the vCenter Single Sign-On username and password, and click Finish.

5. If prompted, verify each of the certificates from the local Platform Services Controller and vCenter Server, and the Platform Services Controller, vCenter Server, and Site Recovery Manager Server on the remote site, and click Yes to accept them.

   The protected and recovery sites are connected. The remote site appears under Sites in the Site Recovery Manager interface.

Establish a Client Connection to the Remote Site Recovery Manager Server Instance

After you connect the Site Recovery Manager Server instances, you must establish a connection from the Site Recovery Manager interface in the vSphere Web Client to the remote Site Recovery Manager Server.

You require a client connection to the remote Site Recovery Manager Server to perform operations that affect both sites, such as configuring inventory mappings and creating protection groups. If you do not establish the client connection, Site Recovery Manager prompts you to log in to the remote site when you attempt operations that affect both sites.
Prerequisites
You connected the Site Recovery Manager Server instances on the protected and recovery sites.

Procedure
1. Connect to vSphere Web Client on one of the sites, and select **Site Recovery > Sites**.
2. Right-click the remote site, select **Login Site**, enter the vCenter Single Sign-On username and password for the remote site, and click **Login**.

Install the Site Recovery Manager License Key
Site Recovery Manager Server requires a license key to operate. Install a Site Recovery Manager license key as soon as possible after you install Site Recovery Manager.

Prerequisites
Site Recovery Manager uses the vSphere licensing infrastructure for license management. Ensure that you have sufficient vSphere licenses for Site Recovery Manager to protect and recover virtual machines on both sites.

Procedure
1. Connect vSphere Web Client to a vCenter Server instance on which Site Recovery Manager is installed.
2. On the vSphere Web Client **Home** tab, click **Licensing**.
3. Click the plus sign on the **Licenses** tab.
4. Enter the Site Recovery Manager license key in the **License Keys** text box and click **Next**.
5. Update the license name, review the details of the license, and click **Finish**.
6. Click the **Assets** tab and click **Solutions**.
7. Right-click the Site Recovery Manager site and select **Assign License**.
8. Select the license from the list of available licenses, and click **OK**.
9. Repeat step Step 1 through Step 8 to assign Site Recovery Manager license keys to all appropriate vCenter Server instances.

Site Recovery Manager Server Does Not Start
Site Recovery Manager depends on other services. If one of those services is not running, the Site Recovery Manager Server does not start.

Problem
After you install, repair, or modify Site Recovery Manager by running the Site Recovery Manager installer, or after you reboot the Site Recovery Manager Server, the Site Recovery Manager Server does not start, or else starts and then stops.
Cause

The Site Recovery Manager Server might not start if the Platform Services Controller or vCenter Server are not running, if it cannot connect to the Site Recovery Manager database, or if other services that Site Recovery Manager requires are not running.

Solution

1. Check the latest Site Recovery Manager Server log file and the Windows Event Viewer for errors.

   Most errors appear in the Site Recovery Manager Server log file. Other errors can appear in the Windows Event Viewer. For example, the Site Recovery Manager database initializes before the Site Recovery Manager logging service starts. If errors occur during database initialization, they appear in the Windows Event Viewer. Errors related to certificate validity also appear in the Windows Event Viewer.

2. Verify that the Platform Services Controller and vCenter Server instances that Site Recovery Manager extends are running.

   If the Platform Services Controller or vCenter Server service are running on a different host to the Site Recovery Manager Server and the vCenter Server service stops, the Site Recovery Manager Server will start successfully and then stop after a short period.

3. Verify that the Site Recovery Manager database service is running.

   - If you use the embedded database, Open the Windows Server Manager utility on the Site Recovery Manager host and select Configuration > Services to check that the VMware vCenter Site Recovery Manager Embedded Database service is running.
   - If you use an external database, check that the appropriate SQL Server or Oracle Server service is running on the database host.

4. Log in to the machine on which you installed the Site Recovery Manager Server.

5. Run the Site Recovery Manager installer in modify mode to check that the installation is configured correctly.

   To facilitate IP address changes in your infrastructure, provide fully qualified domain name (FQDN) whenever possible, rather than IP addresses.

   - Check that the address for Platform Services Controller is correct.
   - If the vCenter Single Sign-On password has changed since you installed Site Recovery Manager, enter the new password.
   - Check that the vCenter Server address is correct. If the vCenter Server address has changed since you installed Site Recovery Manager, for example if the Site Recovery Manager machine uses DHCP instead of a static address, remove, reinstall, and reconfigure Site Recovery Manager.
   - Check that the local host address for Site Recovery Manager Server is correct.
   - Check that the credentials for the Site Recovery Manager database are correct.
- Verify that the Site Recovery Manager database permits sufficient connections. If the Site Recovery Manager logs contain the message GetConnection: Still waiting for available connections, increase the maximum number of database connections. Consult with your database administrator before changing these settings.
- Check that the user account for the Site Recovery Manager service is correct. If you use an account other than the Local System account, check that the username and password are correct.

6 Run the Windows ODBC Data Source Administrator utility to check that Site Recovery Manager can connect to the Site Recovery Manager database.
   a Open, C:\Windows\System32\odbcad32.exe.
   b Select the system DSN for Site Recovery Manager and click Configure.
   c Check the database settings.
      i Check that Site Recovery Manager is attempting to connect to the correct database server.
      ii Check that the login credentials for the Site Recovery Manager database are correct.
      iii Check that the authentication method is correct.
   d Click Test Data Source.
      If the connection is configured correctly, the ODBC Data Source Test window shows a positive result.
   e If the connection test fails, reconfigure the Site Recovery Manager database by using the administration software from your database provider.

7 Open the Windows Server Manager utility and select Configuration > Services.

8 Verify that the services that Site Recovery Manager requires are running.
   - Windows Server
   - Windows Workstation
   - Protected Storage

9 Select the VMware vCenter Site Recovery Manager Server service in the Windows Server Manager utility and click Start or Restart.
Unregister an Incompatible Version of vSphere Replication

Site Recovery Manager requires the corresponding version of vSphere Replication. The Site Recovery Manager installer verifies the version of vSphere Replication and stops if it detects an incompatible version.

Problem

If you install an incompatible version of vSphere Replication after you installed this version of Site Recovery Manager, the verification of the vSphere Replication version is not performed and vSphere Web Client stops working.

Cause

Site Recovery Manager 6.1 is compatible with vSphere Replication 6.1 and vCenter Server 6.0 update 1. You can run vSphere Replication 6.0 or 6.1 with vCenter Server 6.0 update 1. Installing vSphere Replication 6.0 on vCenter Server 6.0 update 1 after you have installed Site Recovery Manager 6.1 causes vSphere Web Client to stop working.

Solution

If the Site Recovery Manager installer detects an incompatible version of vSphere Replication or if you installed an incompatible version of vSphere Replication after you installed this version of Site Recovery Manager, you must upgrade vSphere Replication to the correct version.

If you cannot upgrade vSphere Replication to the correct version, unregister vSphere Replication from vCenter Server. For information about how to unregister vSphere Replication from vCenter Server, see Uninstall vSphere Replication and Unregister vSphere Replication from vCenter Server if the Appliance Was Deleted in vSphere Replication Administration.
Modifying and Uninstalling Site Recovery Manager

You can modify an existing Site Recovery Manager installation to reflect changes in your infrastructure. To uninstall Site Recovery Manager cleanly, you must follow the correct procedure.

- **Modify a Site Recovery Manager Server Installation**
  To change some of the information that you supplied when you installed Site Recovery Manager Server, you can run the Site Recovery Manager installer in modify mode.

- **Reconfigure the Connection Between Sites**
  You must reconfigure the connection between the sites if you made modifications to your Site Recovery Manager installation.

- **Break the Site Pairing and Connect to a New Remote Site**
  To connect a Site Recovery Manager site to a new remote site, you must remove the existing Site Recovery Manager configurations and break the pairing between the existing sites.

- **Repair a Site Recovery Manager Server Installation**
  You can run the Site Recovery Manager installer in repair mode to repair a Site Recovery Manager Server installation.

- **Rename a Site Recovery Manager Site**
  After you have installed Site Recovery Manager, you can rename a site directly in the Site Recovery Manager interface in the vSphere Web Client.

- **Uninstall Site Recovery Manager**
  If you no longer require Site Recovery Manager, you must follow the correct procedure to cleanly uninstall Site Recovery Manager.

- **Uninstall and Reinstall the Same Version of Site Recovery Manager**
  If you uninstall then reinstall the same version of Site Recovery Manager, you must perform certain actions to reconfigure your Site Recovery Manager installation. You must perform these actions even if you retained the database contents when you uninstalled Site Recovery Manager, then connected the new installation to the existing database.
Modify a Site Recovery Manager Server Installation

To change some of the information that you supplied when you installed Site Recovery Manager Server, you can run the Site Recovery Manager installer in modify mode.

Installing Site Recovery Manager Server binds the installation to a number of values that you supply, including the vCenter Server instance to extend, the Site Recovery Manager database type, DSN and credentials, the certificate, and so on. The Site Recovery Manager installer provides a modify mode that allows you to change some of the values that you configured when you installed Site Recovery Manager Server:

- The Platform Services Controller address, if the vCenter Server instance that Site Recovery Manager extends moves to a different Platform Services Controller
- The vCenter Single Sign-On user name and password, if they changed since you installed Site Recovery Manager
- The information with which you register Site Recovery Manager with vCenter Server
- Upload or generate a new certificate
- The user name, password, and connection numbers for the Site Recovery Manager database
- The user account under which the Site Recovery Manager Server service runs

Note If you change the certificate that vCenter Server or Platform Services Controller uses, you must run the Site Recovery Manager installer in modify mode. Running the Site Recovery Manager installer in modify mode updates the Site Recovery Manager certificate thumbprints to reflect the new vCenter Server or Platform Services Controller certificate.

Prerequisites

Verify that you have administrator privileges on Site Recovery Manager Server or that you are a member of the Administrators group. Disable Windows User Account Control (UAC) before you attempt the change operation or select Run as administrator when you start the Site Recovery Manager installer.

Procedure

1. Log in to the Site Recovery Manager Server host.
2. Open Programs and Features from the Windows Control Panel.
3. Select the entry for VMware vCenter Site Recovery Manager and click Change.
4. Click Next.
5. Select Modify and click Next.
6 Verify or modify the information with which to register the Site Recovery Manager extension with Platform Services Controller, and click Next.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Address</td>
<td>You can change the Platform Services Controller address if vCenter Server migrated to a different Platform Services Controller after the initial installation of Site Recovery Manager.</td>
</tr>
<tr>
<td></td>
<td><strong>Important</strong> If you change the Platform Services Controller address, you must reconfigure the connection between the Site Recovery Manager sites after you have updated the installation.</td>
</tr>
<tr>
<td>HTTPS Port</td>
<td>Change the Platform Services Controller port if it changed after the initial installation of Site Recovery Manager.</td>
</tr>
<tr>
<td>Username</td>
<td>Modify the vCenter Single Sign-On user name, if it has changed since the initial installation.</td>
</tr>
<tr>
<td>Password</td>
<td>Enter the vCenter Single Sign-On password.</td>
</tr>
</tbody>
</table>

7 If prompted, verify the Platform Services Controller certificate and click Accept to accept it.

8 Verify the vCenter Server instance that Site Recovery Manager extends, and click Next.

You cannot use the installer's modify mode to change the vCenter Server instance that Site Recovery Manager extends.

9 Verify or modify the information with which to register the Site Recovery Manager extension with vCenter Server, and click Next.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Administrator E-mail</td>
<td>Modify this value if the Site Recovery Manager administrator has changed after you installed Site Recovery Manager Server.</td>
</tr>
<tr>
<td>Local Host</td>
<td>The address of the host on which Site Recovery Manager Server runs. If you change this value, you must either regenerate the certificate or provide a new certificate that includes the new address in Step 10.</td>
</tr>
<tr>
<td></td>
<td><strong>Important</strong> To facilitate IP address changes in your infrastructure, provide a fully qualified domain name (FQDN) whenever possible, rather than an IP address.</td>
</tr>
<tr>
<td>Listener Port</td>
<td>The port for all HTTPS traffic between Site Recovery Manager Server and vCenter Server.</td>
</tr>
</tbody>
</table>
10 Select a certificate type and click **Next**.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Automatically generate a certificate</td>
<td>Select this option to generate a new auto-generated certificate.</td>
</tr>
<tr>
<td>Use a PKCS #12 certificate file</td>
<td>Select this option to upload a new custom certificate.</td>
</tr>
<tr>
<td>Use existing certificate</td>
<td>Select this option to retain the current certificate. If the installed certificate is not valid, this option is unavailable.</td>
</tr>
</tbody>
</table>

If you do not select **Use existing certificate**, you are prompted to supply additional details such as the certificate location or strings to use for Organization and Organizational Unit.

**Important** If you modified the Local Host value for Site Recovery Manager Server in **Step 9**, you must select **Automatically generate a certificate** to regenerate the certificate or **Use a PKCS #12 certificate file** to upload a certificate that includes the new Site Recovery Manager Server address. If you select **Use existing certificate**, the installation modification succeeds, but attempts to log in to Site Recovery Manager fail because the certificate contains an incorrect address for the Site Recovery Manager Server host.

11 Verify or modify the database configuration information and click **Next**.

If you selected the embedded database when you installed Site Recovery Manager, you cannot modify the installation to use an external database, or the reverse.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Data Source Name</td>
<td>The DSN for the Site Recovery Manager database. This only appears if you use the embedded database. You cannot change this value.</td>
</tr>
<tr>
<td>Database User Name</td>
<td>A user ID valid for the specified database. Modify this value if the database user account has changed after you installed Site Recovery Manager Server.</td>
</tr>
<tr>
<td>Database Password</td>
<td>The password for the specified user ID. Modify this value if the password for the database user account has changed after you installed Site Recovery Manager Server. You must enter this value in all cases.</td>
</tr>
<tr>
<td>Database Port</td>
<td>This only appears if you use the embedded database. You cannot change this value.</td>
</tr>
<tr>
<td>Connection Count</td>
<td>Modify the initial connection pool size. If all connections are in use and a new one is needed, a connection is created as long as it does not exceed the maximum number of connections allowed. It is faster for Site Recovery Manager to use a connection from the pool than to create one. The maximum value that you can set depends on your database configuration. In most cases, it is not necessary to change this setting. Before changing this setting, consult with your database administrator. Setting the value too high can lead to database errors.</td>
</tr>
<tr>
<td>Max Connections</td>
<td>Modify the maximum number of database connections that can be open simultaneously. The maximum value that you can set depends on your database configuration. If the database administrator restricted the number of connections that the database can have open, this value cannot exceed that number. In most cases, it is not necessary to change this setting. Before you change this setting, consult with your database administrator. Setting the value too high can lead to database errors.</td>
</tr>
</tbody>
</table>
12 Select or deselect the **Use Local System account** check box to change the user account under which the Site Recovery Manager Server service runs, and click **Next**.

- If you deselect **Use Local System account**, you must provide a username and password for a valid user account.
- If you are using SQL Server with Integrated Windows Authentication, the username text box shows the username of the account that is running the installer and cannot be modified.

13 Click **Install** to modify the installation.

The installer makes the requested modifications and restarts the Site Recovery Manager Server.

**What to do next**

When the modification operation is finished and the Site Recovery Manager Server restarts, log in to the vSphere Web Client to check the connection between the sites. If the connection is broken, or if you changed the Platform Services Controller address, reconfigure the site pairing. For instructions about how to reconfigure the site pairing, see **Reconfigure the Connection Between Sites**.

**Reconfigure the Connection Between Sites**

You must reconfigure the connection between the sites if you made modifications to your Site Recovery Manager installation.

You cannot reconfigure the site pairing to connect Site Recovery Manager to a different vCenter Server instance. You reconfigure an existing pairing to update Site Recovery Manager on both sites if the infrastructure has changed on one or both of the sites.

- You upgraded Site Recovery Manager to a new version.
- You changed the Site Recovery Manager certificate.
- You changed the Platform Services Controller or vCenter Server certificate.
- You changed the Platform Services Controller address.

**Procedure**

1. In the vSphere Web Client, click **Site Recovery > Sites**.
2. Right-click a site and select **Reconfigure Pairing**.

   You can initiate the reconfiguration from either site, even if you only changed the installation on one of the sites.

3. Enter the address of the Platform Services Controller on the remote site and click **Next**.
4. Select the vCenter Server instance with which Site Recovery Manager is registered on the remote site, provide the vCenter Single Sign-On username and password, and click **Finish**.

   If the Platform Services Controller manages more than one vCenter Server instance, the other vCenter Server instances appear in the list but you cannot select a different instance. You can only select the vCenter Server instance that Site Recovery Manager already extends.
Break the Site Pairing and Connect to a New Remote Site

To connect a Site Recovery Manager site to a new remote site, you must remove the existing Site Recovery Manager configurations and break the pairing between the existing sites.

Site pairing makes modifications on both Site Recovery Manager sites. You cannot reconfigure an existing pairing between Site Recovery Manager sites to connect Site Recovery Manager on one site to a new Site Recovery Manager site. You must remove all configuration from both sites in the existing pair, then break the connection between the sites before you can configure a new site pairing. You cannot break the site pairing until you have removed all existing configurations between the sites.

Prerequisites

- You have an existing Site Recovery Manager installation with two connected sites.
- Make a full backup of the Site Recovery Manager database on both sites by using the tools that the database software provides. For instructions about how to back up the embedded database, see Back Up and Restore the Embedded vPostgres Database.

Procedure

1. In the vSphere Web Client, click Site Recovery > Recovery Plans > Objects, highlight all recovery plans, right-click and select Delete Recovery Plan.

   You cannot delete recovery plans that are running.

2. Select Site Recovery > Protection Groups, select a protection group, and click Related Objects > Virtual Machines.

3. Highlight all virtual machines, right-click, and select Remove Protection.

   Removing protection from a virtual machine deletes the placeholder virtual machine from the recovery site. Repeat this operation for all protection groups.

   **Note** This step applies to array-based protection groups and to vSphere Replication protection groups. You cannot remove protection from virtual machines in storage policy protection groups. Skip this step for storage policy protection groups.

4. In the Protection Groups > Objects tab, highlight all protection groups, right-click and select Delete Protection Group.

   You cannot delete a protection group that is included in a recovery plan. You cannot delete array-based or vSphere Replication protection groups that contain virtual machines on which protection is still configured.

5. Select Site Recovery > Sites, select a site, click Manage, and remove all inventory mappings.

   a. Click each of the Network Mappings, Folder Mappings, Resource Mappings, and Storage Policy Mappings tabs.

   b. In each tab, right-click a mapping, and select Remove Mapping Type Mapping
6 For both sites, click Placeholder Datastores, right-click the placeholder datastore, and select Remove Placeholder Datastore.

7 (Optional) If you use array-based replication, select Site Recovery > Array-Based Replication, right-click the array manager and select Remove Array Manager.

8 Select Site Recovery > Sites, right-click a site and select Break Pairing.

Breaking the site pairing removes all information related to registering Site Recovery Manager with Site Recovery Manager, vCenter Server, and the Platform Services Controller on the remote site. The connection between the sites is broken. You can reconfigure Site Recovery Manager to connect to a new remote site.

What to do next

- Install a new Site Recovery Manager instance on the new remote site. For instructions about installing Site Recovery Manager, see Install Site Recovery Manager Server.

  Important The new Site Recovery Manager instance must have the same Site Recovery Manager extension ID as the existing site.

- Optionally uninstall Site Recovery Manager Server from the previous remote site. For instructions about uninstalling Site Recovery Manager Server, see the steps of Uninstall Site Recovery Manager from the Break Pairing step onwards.

- Reconfigure the inventory mappings and placeholder datastore mappings to map objects on the existing site to objects on the new remote site. For instructions about configuring mappings, see Site Recovery Manager Administration.

- Reconfigure the replication of virtual machines from the existing site to the new remote site. For information about configuring array-based replication and vSphere Replication, see Replicating Virtual Machines in Site Recovery Manager Administration.

- Create new protection groups and recovery plans to recover virtual machines to the new remote site. For information about creating protection groups and recovery plans, see Site Recovery Manager Administration.

Repair a Site Recovery Manager Server Installation

You can run the Site Recovery Manager installer in repair mode to repair a Site Recovery Manager Server installation.

Running the installer in repair mode fixes missing or corrupted files, shortcuts, and registry entries in the Site Recovery Manager Server installation.

Caution Do not run the Site Recovery Manager installer in repair mode on the protected site and on the recovery site simultaneously.
Prerequisites
Verify that you have administrator privileges on Site Recovery Manager Server or that you are a member of the Administrators group. Disable Windows User Account Control (UAC) before you attempt the change operation or select Run as administrator when you start the Site Recovery Manager installer.

Procedure
1. Log in to the Site Recovery Manager Server host.
2. Open Programs and Features from the Windows Control Panel.
3. Select the entry for VMware vCenter Site Recovery Manager and click Change.
4. Click Next.
5. Select Repair and click Next.
6. Click Install to repair the installation.

   The installer makes any necessary repairs and restarts Site Recovery Manager Server.

Rename a Site Recovery Manager Site
After you have installed Site Recovery Manager, you can rename a site directly in the Site Recovery Manager interface in the vSphere Web Client.

Procedure
1. In the vSphere Web Client, click Site Recovery > Sites, and select a site.
2. Right-click the site and select Rename Site.
3. Enter a new name for the site and click OK.

Uninstall Site Recovery Manager
If you no longer require Site Recovery Manager, you must follow the correct procedure to cleanly uninstall Site Recovery Manager.

Installing Site Recovery Manager, creating inventory mappings, protecting virtual machines by creating protection groups, and creating and running recovery plans makes significant changes on both Site Recovery Manager sites. Before you uninstall Site Recovery Manager, you must remove all Site Recovery Manager configurations from both sites in the correct order. If you do not remove all configurations before uninstalling Site Recovery Manager, some Site Recovery Manager components, such as placeholder virtual machines, might remain in your infrastructure.

If you use Site Recovery Manager with vSphere Replication, you can continue to use vSphere Replication after you uninstall Site Recovery Manager.
Procedure

1. In the vSphere Web Client, click Site Recovery > Recovery Plans > Objects, highlight all recovery plans, right-click and select Delete Recovery Plan.

   You cannot delete recovery plans that are running.

2. Select Site Recovery > Protection Groups, select a protection group, and click Related Objects > Virtual Machines.

3. Highlight all virtual machines, right-click, and select Remove Protection.

   Removing protection from a virtual machine deletes the placeholder virtual machine from the recovery site. Repeat this operation for all protection groups.

   **Note** This step applies to array-based protection groups and to vSphere Replication protection groups. You cannot remove protection from virtual machines in storage policy protection groups. Skip this step for storage policy protection groups.

4. In the Protection Groups > Objects tab, highlight all protection groups, right-click and select Delete Protection Group.

   You cannot delete a protection group that is included in a recovery plan. You cannot delete array-based or vSphere Replication protection groups that contain virtual machines on which protection is still configured.

5. Select Site Recovery > Sites, select a site, click Manage, and remove all inventory mappings.
   a. Click each of the Network Mappings, Folder Mappings, Resource Mappings, and Storage Policy Mappings tabs.
   b. In each tab, right-click a mapping, and select Remove Mapping Type Mapping

6. For both sites, click Placeholder Datastores, right-click the placeholder datastore, and select Remove Placeholder Datastore.

7. (Optional) If you use array-based replication, select Site Recovery > Array-Based Replication, right-click the array manager and select Remove Array Manager.

8. Select Site Recovery > Sites, right-click a site and select Break Pairing.

   Breaking the site pairing removes all information related to registering Site Recovery Manager with Site Recovery Manager, vCenter Server, and the Platform Services Controller on the remote site.

9. Log into the Site Recovery Manager Server host for one of the sites.

10. (Optional) If you use array-based replication, uninstall the storage replication adapter (SRA).

    For instructions about how to uninstall the SRA, see the documentation from the SRA provider.

11. Use Windows Control Panel to uninstall Site Recovery Manager, selecting the option Delete Site Recovery Manager Data.

    Do not uninstall the Site Recovery Manager database before you uninstall Site Recovery Manager.
12 (Optional) If you use the embedded database, use Windows Control Panel to uninstall the Site Recovery Manager Embedded Database.

13 Repeat Step 9 to Step 12 on the other site.

**Uninstall and Reinstall the Same Version of Site Recovery Manager**

If you uninstall then reinstall the same version of Site Recovery Manager, you must perform certain actions to reconfigure your Site Recovery Manager installation. You must perform these actions even if you retained the database contents when you uninstalled Site Recovery Manager, then connected the new installation to the existing database.

If you configured advanced settings in the previous installation, these advanced settings are not retained if you uninstall and then reinstall the same version of Site Recovery Manager. This is by design.

**Procedure**

1 (Optional) If you configured advanced settings in the existing installation, take a note of the advanced settings.

   You configure advanced settings in **Site Recovery > Sites > Site > Manage > Advanced Settings** in the vSphere Web Client

2 Uninstall Site Recovery Manager, without deleting its data.

3 Reinstall Site Recovery Manager.

   During reinstallation, connect Site Recovery Manager to the same vCenter Server instance and the same database as the previous installation.

4 Reconfigure the connection between the sites.

5 Reconfigure Storage Array Managers (SRAs) to enter the SRA credentials.

6 Reconfigure any advanced settings.

**Migrating a Site Recovery Manager Server to Run on a Different Host**

To migrate a Site Recovery Manager server to a new host, you must install Site Recovery Manager on the new host and supply database connection information used by the old installation.

You use this workflow to migrate a Site Recovery Manager server from one host to another and retain data from the previous installation, which is stored in the Site Recovery Manager database.

**Prerequisites**

- Backup the Site Recovery Manager database.
- Uninstall the old Site Recovery Manager preserving the database.
Procedure

1. Double-click the Site Recovery Manager installer, select an installation language, and click **OK**.

2. Follow the installer prompts to accept the license agreement, and verify that you satisfied the installation prerequisites.

3. Choose where to install Site Recovery Manager Server, and click **Next**.
   - Keep the default destination folder.
   - Click **Change** to change the destination folder, and select a target volume.

   The default installation folder for Site Recovery Manager is `C:\Program Files\VMware\VMware vCenter Site Recovery Manager`. If you use a different folder, the pathname cannot be longer than 120 characters including the end slash, and cannot include non-ASCII characters.

4. Enter information about the Platform Services Controller at the site where you are installing Site Recovery Manager and click **Next**.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Address</td>
<td>The host name or IP address of the Platform Services Controller for the vCenter Server with which to register Site Recovery Manager. Enter the host name in lowercase letters. After installation is complete and you are configuring the connection between the protected and recovery sites, supply this host name or IP address exactly as you enter it here, because it is subject to case-sensitive comparisons.</td>
</tr>
<tr>
<td></td>
<td><strong>Important</strong> To facilitate IP address changes in your infrastructure, provide a fully qualified domain name (FQDN) whenever possible, rather than an IP address.</td>
</tr>
<tr>
<td></td>
<td><strong>Important</strong> If the Platform Services Controller uses an FQDN rather than an IP address, you must specify the FQDN when you install Site Recovery Manager.</td>
</tr>
<tr>
<td>HTTPS Port</td>
<td>Accept the default value of 443 or enter a new value if Platform Services Controller uses a different port. Platform Services Controller only supports connections over HTTPS and does not support HTTP connections.</td>
</tr>
<tr>
<td>Username</td>
<td>The vCenter Single Sign-On user name for the vCenter Single Sign-On domain to which this Platform Services Controller instance belongs. This user account must be a member of the vCenter Single Sign-On Administrator group on the Platform Services Controller instance. Only members of the Administrator group have the necessary permissions to create or recreate the Site Recovery Manager solution user.</td>
</tr>
<tr>
<td>Password</td>
<td>The password for the specified vCenter Single Sign-On user name. The password text box can be empty.</td>
</tr>
</tbody>
</table>

5. If prompted, verify the Platform Services Controller certificate and click **Accept** to accept it.
6  Select the vCenter Server instance with which to register Site Recovery Manager and click **Next**.

**Important** The drop-down menu includes all of the vCenter Server instances that are registered with the Platform Services Controller. In an environment that uses Enhanced Linked Mode, it can also include vCenter Server instances from other Platform Services Controller instances. Make sure that you select the correct vCenter Server instance. Once the Site Recovery Manager installation is complete, you cannot modify it to select a different vCenter Server instance.

7  Enter information with which to register the Site Recovery Manager extension with vCenter Server, and click **Next**.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Local Site Name</strong></td>
<td>A name for this Site Recovery Manager site, that appears in the Site Recovery Manager interface. The vCenter Server address is used by default, but you can enter any name. You cannot use the same name that you use for another Site Recovery Manager installation with which this one will be paired.</td>
</tr>
<tr>
<td><strong>Administrator E-mail</strong></td>
<td>Email address of the Site Recovery Manager administrator. This information is required even though you use the standard vCenter Server alarms to configure email notifications for Site Recovery Manager events.</td>
</tr>
</tbody>
</table>
| **Local Host** | Name or IP address of the local host. The Site Recovery Manager installer obtains this value. Only change it if it is incorrect. For example, the local host might have more than one network interface and the one that the Site Recovery Manager installer detects is not the interface you want to use.  

**Important** To facilitate IP address changes in your infrastructure, provide a fully qualified domain name (FQDN) whenever possible, rather than an IP address. |
| **Listener Port** | HTTPS port for all management traffic to Site Recovery Manager Server, including traffic with external API clients for task automation. The port is also used by vSphere Web Client to download the Site Recovery Manager client plugin. This port must be accessible from the vCenter Server proxy system. Do not change the port unless the default of 9086 causes port conflicts. |
8 Select the default Site Recovery Manager plug-in identifier, or create a plug-in identifier for this Site Recovery Manager Server pair, and click Next.

Both Site Recovery Manager Server instances in a site pair must use the same plug-in identifier.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Default SRM Plug-in Identifier</td>
<td>Use this option when you install Site Recovery Manager in a standard configuration with one protected site and one recovery site.</td>
</tr>
<tr>
<td>Custom SRM Plug-in Identifier</td>
<td>Use this option when you install Site Recovery Manager in a shared recovery site configuration, with multiple protected sites and one recovery site. Enter the details of the plug-in identifier.</td>
</tr>
<tr>
<td><strong>Plug-in ID</strong></td>
<td>A unique identifier. Assign the same identifier to the Site Recovery Manager Server instances on the protected site and the shared recovery site.</td>
</tr>
<tr>
<td><strong>Organization</strong></td>
<td>The name of the organization to which this Site Recovery Manager Server pair belongs. This name helps to identify to Site Recovery Manager Server pairs in a shared recovery site configuration, especially when multiple organizations use the shared recovery site.</td>
</tr>
<tr>
<td><strong>Description</strong></td>
<td>An optional description of this Site Recovery Manager Server pair.</td>
</tr>
</tbody>
</table>

9 Select a certificate type and click Next.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
</table>
| Automatically generate certificate | Use an automatically generated certificate:  
  a Select **Automatically generate certificate** and click Next.  
  b Enter text values for your organization and organization unit, typically your company name and the name of your group in the company.  
  c Click Next. |
| Load a certificate file       | Use a custom certificate:  
  a Select **Use a PKCS#12 certificate file** and click Next.  
  b Click Browse, navigate to the certificate file, and click Open. The certificate file must contain exactly one certificate with exactly one private key matching the certificate.  
  c Enter the certificate password.  
  d Click Next. |

10 Select to use a custom database, and click Next.

Select the 64-bit DSN of the old database from the drop-down menu. You can also click DSN Setup to start the Windows 64-bit ODBC Administrator tool, to view the existing DSNs, or to create a new 64-bit system DSN for the Site Recovery Manager database.
11 Provide the Site Recovery Manager database configuration information and click **Next**.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Database Username</strong></td>
<td>Enter the user name for an existing database user account to use with a custom database. This option is disabled if you use SQL Server with Integrated Windows Authentication. In this case, the credentials of the user account running the Site Recovery Manager installer are used to authenticate with SQL Server. This account is also used to run the Site Recovery Manager service, to guarantee that Site Recovery Manager can connect to the database.</td>
</tr>
<tr>
<td><strong>Database Password</strong></td>
<td>Enter the password for an existing database user account to use with a custom database. This option is disabled if you use SQL Server with Integrated Windows Authentication.</td>
</tr>
<tr>
<td><strong>Connection Count</strong></td>
<td>Enter the initial connection pool size. If all connections are in use and a new one is needed, a connection is created as long as it does not exceed the maximum number of connections allowed. It is faster for Site Recovery Manager to use a connection from the pool than to create one. The maximum value that you can set depends on your database configuration. In most cases, it is not necessary to change this setting. Before changing this setting, consult with your database administrator. Setting the value too high can lead to database errors.</td>
</tr>
<tr>
<td><strong>Max Connections</strong></td>
<td>Enter the maximum number of database connections that can be open simultaneously. The maximum value that you can set depends on your database configuration. If the database administrator restricted the number of connections that the database can have open, this value cannot exceed that number. In most cases, it is not necessary to change this setting. Before you change this setting, consult with your database administrator. Setting the value too high can lead to database errors.</td>
</tr>
</tbody>
</table>

12 Select to use existing data, and click **Next**.

13 Select the user account under which to run the Site Recovery Manager Server service and click **Next**.

- Select **Use Local System Account** to run the Site Recovery Manager Server service under the Local System account.
- Enter the username and password of an existing LDAP user account to run the Site Recovery Manager Server service under a different user account. This can be any user account, including local users, that is a member of the built-in Administrators group.

This option is not available if you use an SQL Server database with Integrated Windows Authentication. In this case, the Site Recovery Manager Server service runs under the account that you use to install Site Recovery Manager.

14 Click **Install**.

15 When the installation is finished, click **Finish**.

Site Recovery Manager server is migrated on a different host.
You can upgrade existing Site Recovery Manager installations. The Site Recovery Manager upgrade process preserves existing information about Site Recovery Manager configurations.

Because of update release schedules, upgrading to certain Site Recovery Manager 6.1.x update releases is not supported for all 6.0.x releases. For information about supported upgrade paths, see Upgrade Path > VMware vCenter Site Recovery Manager in the VMware Product Interoperability Matrixes at http://partnerweb.vmware.com/comp_guide2/sim/interop_matrix.php? before you upgrade.

**Important** Upgrading from Site Recovery Manager 5.x to Site Recovery Manager 6.1 is not supported. Upgrade Site Recovery Manager 5.x to a Site Recovery Manager 6.0.x release before you upgrade to Site Recovery Manager 6.1. See Upgrading Site Recovery Manager in the Site Recovery Manager 6.0 documentation for information about upgrading to 6.0.x.

To revert to Site Recovery Manager 6.0.x after upgrading to Site Recovery Manager 6.1, see Revert to a Previous Release of Site Recovery Manager.

- **Information That Site Recovery Manager Upgrade Preserves**
  The Site Recovery Manager upgrade procedure preserves information from existing installations.

- **Types of Upgrade that Site Recovery Manager Supports**
  Upgrading Site Recovery Manager requires that you upgrade vCenter Server. Site Recovery Manager supports different upgrade configurations.

- **Upgrade Site Recovery Manager**
  You perform several tasks to upgrade Site Recovery Manager.

**Information That Site Recovery Manager Upgrade Preserves**

The Site Recovery Manager upgrade procedure preserves information from existing installations. Site Recovery Manager preserves settings and configurations that you created for the previous release.

- Datastore groups
- Protection groups
- Inventory mappings
- Recovery plans
- IP customizations for individual virtual machines
- Custom roles and their memberships
- Site Recovery Manager object permissions in vSphere
- Custom alarms and alarm actions
- Test plan histories
- Security certificates
- Mass IP customization files (CSVs)

**Important**  During an upgrade, Site Recovery Manager does not retain any advanced settings that you configured in the previous installation. This is by design. Due to changes in default values or improvements in performance, advanced settings that you set in a previous version of Site Recovery Manager might not be required by or compatible with the new version.

**Important**  During an upgrade, Site Recovery Manager preserves only protection groups and recovery plans that are in a valid state. Site Recovery Manager discards protection groups or recovery plans that are in an invalid state.
## Types of Upgrade that Site Recovery Manager Supports

Upgrading Site Recovery Manager requires that you upgrade vCenter Server. Site Recovery Manager supports different upgrade configurations.

### Table 8-1. Types of vCenter Server and Site Recovery Manager Upgrades

<table>
<thead>
<tr>
<th>Upgrade Type</th>
<th>Description</th>
<th>Supported</th>
</tr>
</thead>
<tbody>
<tr>
<td>In-place upgrade of Site Recovery Manager</td>
<td>The simplest upgrade path. This path involves upgrading the Platform Services Controller and vCenter Server instances associated with Site Recovery Manager before upgrading Site Recovery Manager Server. Run the new version of the Site Recovery Manager installer on the existing Site Recovery Manager Server host machine, connecting to the existing database.</td>
<td>Yes</td>
</tr>
<tr>
<td>Upgrade Site Recovery Manager with migration</td>
<td>This path involves upgrading the Platform Services Controller and vCenter Server instances associated with Site Recovery Manager before upgrading Site Recovery Manager Server. To migrate Site Recovery Manager to a different host or virtual machine as part of the Site Recovery Manager upgrade, stop the existing Site Recovery Manager Server. Do not uninstall the previous release of Site Recovery Manager Server and make sure that you retain the database contents. Run the new version of the Site Recovery Manager installer on the new host or virtual machine, connecting to the existing Platform Services Controller and database.</td>
<td>Yes</td>
</tr>
<tr>
<td>New vCenter Server installation with migration of Site Recovery Manager</td>
<td>Create new installations of vCenter Server and migrate Site Recovery Manager Server to these new vCenter Server instances.</td>
<td>No</td>
</tr>
</tbody>
</table>
Upgrade Site Recovery Manager

You perform several tasks to upgrade Site Recovery Manager.

Because of update release schedules, upgrading to certain Site Recovery Manager 6.1.x update releases is not supported for all 6.0.x releases. For information about supported upgrade paths, see Upgrade Path > VMware vCenter Site Recovery Manager in the VMware Product Interoperability Matrixes at http://partnerweb.vmware.com/comp_guide2/sim/interop_matrix.php? before you upgrade.

**Important** Upgrading from Site Recovery Manager 5.x to Site Recovery Manager 6.1 is not supported. Upgrade Site Recovery Manager 5.x to a Site Recovery Manager 6.0.x release before you upgrade to Site Recovery Manager 6.1. See Upgrading Site Recovery Manager in the Site Recovery Manager 6.0 documentation for information about upgrading to 6.0.x.

You must perform the upgrade tasks in order. Complete all of the upgrade tasks on the protected site first, then complete the tasks on the recovery site.

**Procedure**

1. **Order of Upgrading vSphere and Site Recovery Manager Components**
   You must upgrade certain components of your vSphere environment before you upgrade Site Recovery Manager.

2. **Prerequisites and Best Practices for Site Recovery Manager Upgrade**
   Before you upgrade Site Recovery Manager, you must perform preparatory tasks on both Site Recovery Manager sites and verify that you have certain information.

3. **In-Place Upgrade of Site Recovery Manager Server**
   An in-place upgrade provides a quick way to upgrade Site Recovery Manager Server without changing the information that you provided for the previous installation.

4. **Upgrade Site Recovery Manager Server with Migration**
   You can upgrade Site Recovery Manager and migrate Site Recovery Manager Server to a different host than the previous Site Recovery Manager Server installation.

5. **Configure and Verify the Upgraded Site Recovery Manager Installation**
   You must configure the upgraded components to establish a working Site Recovery Manager installation.

6. **Revert to a Previous Release of Site Recovery Manager**
   To revert to a previous release of Site Recovery Manager, you must uninstall Site Recovery Manager from the protected and recovery sites. You can then reinstall the previous release.
Order of Upgrading vSphere and Site Recovery Manager Components

You must upgrade certain components of your vSphere environment before you upgrade Site Recovery Manager.

Upgrade the components on the protected site before you upgrade the components on the recovery site. Upgrading the protected site first allows you to perform a disaster recovery on the recovery site if you encounter problems during the upgrade that render the protected site unusable. The exception is the ESXi hosts, which you can upgrade after you finish upgrading the other components on the protected and recovery sites.

**Important** If you configured bidirectional protection, in which each site acts as the recovery site for the virtual machines on the other site, upgrade the most critical of the sites first.

1. Upgrade the Platform Services Controller and all components of vCenter Server on the protected site.
2. If you use vSphere Replication, upgrade the vSphere Replication deployment on the protected site.
3. Upgrade Site Recovery Manager Server on the protected site.
4. If you use array-based replication, upgrade the storage replication adapters (SRA) on the protected site.
5. Upgrade the Platform Services Controller and all components of vCenter Server on the recovery site.
6. If you use vSphere Replication, upgrade the vSphere Replication deployment on the recovery site.
7. Upgrade Site Recovery Manager Server on the recovery site.
8. If you use array-based replication, upgrade the storage replication adapters (SRA) on the recovery site.
9. Verify the connection between the Site Recovery Manager sites.
10. Verify that your protection groups and recovery plans are still valid.
11. Upgrade ESXi Server on the recovery site.
12. Upgrade ESXi Server on the protected site.
13. Upgrade the virtual hardware and VMware Tools on the virtual machines on the ESXi hosts.
Prerequisites and Best Practices for Site Recovery Manager Upgrade

Before you upgrade Site Recovery Manager, you must perform preparatory tasks on both Site Recovery Manager sites and verify that you have certain information.

- Make a full backup of the Site Recovery Manager database by using the tools that the database software provides. For information about how to back up the embedded database, see Back Up and Restore the Embedded vPostgres Database. Migration of data from an external database to the embedded database is not supported. Failure to back up the database results in the loss of all Site Recovery Manager data if the upgrade fails.

- If you configured advanced settings in the existing installation, take a note of the settings that you configured in Site Recovery > Sites > Site > Manage > Advanced Settings in the vSphere Web Client.

- Because of update release schedules, upgrading to certain Site Recovery Manager 6.1.x update releases is not supported for all 6.0.x releases. For information about supported upgrade paths, see Upgrade Path > VMware vCenter Site Recovery Manager in the VMware Product Interoperability Matrixes at http://partnerweb.vmware.com/comp_guide2/sim/interop_matrix.php? before you upgrade.

  Important Upgrading from Site Recovery Manager 5.x to Site Recovery Manager 6.1 is not supported. Upgrade Site Recovery Manager 5.x to a Site Recovery Manager 6.0.x release before you upgrade to Site Recovery Manager 6.1. See Upgrading Site Recovery Manager in the Site Recovery Manager 6.0 documentation for information about upgrading to 6.0.x.

- The local and remote Platform Services Controller and vCenter Server instances must be running when you upgrade Site Recovery Manager.

- Upgrade Platform Services Controller and vCenter Server on the site on which you are upgrading Site Recovery Manager.
  - For information about how to upgrade vCenter Server and its components, see vSphere Upgrade in the VMware vSphere ESXi and vCenter Server 6.0 Documentation.
  - For information about compatibility between vCenter Server and Site Recovery Manager versions, see vCenter Server Requirements in the Compatibility Matrixes for Site Recovery Manager 6.1 at https://www.vmware.com/support/srm/srm-compat-matrix-6-1.html.
  - For information about the order in which to upgrade the components on each site, see Order of Upgrading vSphere and Site Recovery Manager Components.

- Upgrade the Platform Services Controller, all of the vCenter Server components, and Site Recovery Manager on one site before you upgrade the Platform Services Controller, vCenter Server, and Site Recovery Manager on the other site.

- Obtain the address of the Platform Services Controller instance for both sites. The Platform Services Controller must be running and accessible during Site Recovery Manager installation.
- Obtain the vCenter Single Sign-On administrator user name and password for both of the local and remote sites.

- Obtain the user name and password for the Site Recovery Manager database, if you are not using the embedded database.

- To use Site Recovery Manager with vSphere Replication, upgrade vSphere Replication on both of the protected and recovery sites before you upgrade Site Recovery Manager Server. The Site Recovery Manager installer verifies the version of vSphere Replication during the upgrade and stops if it detects an incompatible version. This verification is not performed if you install vSphere Replication after you upgrade Site Recovery Manager Server, which might lead to incompatible versions. Incompatible versions of Site Recovery Manager and vSphere Replication cause the vSphere Web Client to stop working.

  - For information about how to upgrade vSphere Replication, see Upgrading vSphere Replication in vSphere Replication Administration.

  - For information about compatibility between vSphere Replication and Site Recovery Manager versions, see vSphere Replication Requirements in the Compatibility Matrixes for Site Recovery Manager 6.1 at https://www.vmware.com/support/srm/srm-comp-matrix-6-1.html.

- If you cannot upgrade an existing incompatible version of vSphere Replication, you must unregister vSphere Replication from both vCenter Server instances before you upgrade Site Recovery Manager. Incompatible versions of Site Recovery Manager and vSphere Replication cause the vSphere Web Client to stop working. See Unregister an Incompatible Version of vSphere Replication.

- The Site Recovery Manager installer presents the SSL/TLS certificates of the vCenter Server components for validation when it runs. Obtain the necessary information to allow you validate the certificates for the Platform Services Controller instance on the local site and the Platform Services Controller and vCenter Server instances on the remote site.

- If you use custom certificates, obtain an appropriate certificate file. Custom certificates must use at least the SHA1, or preferably SHA256, thumbprint algorithm. This release of Site Recovery Manager does not support certificates that use the MD5 thumbprint algorithm. See Requirements When Using Custom SSL/TLS Certificates with Site Recovery Manager.

- Download the Site Recovery Manager installation file to a folder on the machines on which to upgrade Site Recovery Manager.

- Verify that no reboot is pending on the Windows machine on which to install Site Recovery Manager Server. Verify that no other installation is running, including the silent installation of Windows updates. Pending reboots or running installations can cause the installation of Site Recovery Manager Server or the embedded Site Recovery Manager database to fail.
Important Verify that there are no pending cleanup operations on recovery plans and that there are no configuration issues for the virtual machines that Site Recovery Manager protects.

- All recovery plans are in the Ready state.
- The protection status of all of the protection groups is OK.
- The protection status of all of the individual virtual machines in the protection groups is OK.
- The recovery status of all of the protection groups is Ready.

Optimize the Adobe Flash Player settings in your browser to increase the amount of storage space that the vSphere Web Client can use. Performing a recovery with Site Recovery Manager can sometimes exceed the default amount of storage space that Flash Player is permitted to consume. For information about how to optimize the Flash Player settings for Site Recovery Manager in the vSphere Web Client, see http://kb.vmware.com/kb/2106096.

### In-Place Upgrade of Site Recovery Manager Server

An in-place upgrade provides a quick way to upgrade Site Recovery Manager Server without changing the information that you provided for the previous installation.

With an in-place upgrade, you upgrade Site Recovery Manager Server on the same host machine as an existing Site Recovery Manager Server installation. To upgrade Site Recovery Manager and migrate the Site Recovery Manager Server to a different host machine, see Upgrade Site Recovery Manager Server with Migration.

**Note** If you are updating Site Recovery Manager 6.1 to a 6.1.x update release or to a 6.1.x.x patch release, you must perform in-place upgrade. You cannot perform upgrade with migration if you are updating Site Recovery Manager 6.1 to a 6.1.x update release or to a 6.1.x.x patch release.

When you upgrade Site Recovery Manager Server, you provide the address of the Platform Services Controller that the upgraded vCenter Server instance uses. If the address of the Platform Services Controller changed during upgrade, you provide the new address when you upgrade Site Recovery Manager Server. For the subsequent steps of the upgrade, the Site Recovery Manager installer reuses information about vCenter Server connections, certificates, and database configuration from the previous Site Recovery Manager installation. The installer populates the text boxes in the installation wizard with the values from the previous installation.

To change installation information, for example, database connections, certificate location, or administrator credentials, you must run the installer in modify mode after you upgrade an existing Site Recovery Manager Server.

If existing configuration information is invalid for the upgrade, the upgrade fails. For example, the upgrade fails if the database is not accessible at the same DSN, or if vCenter Server is not accessible at the same port.

During upgrade, you cannot change the vCenter Server instance to which Site Recovery Manager connects. To connect to a different vCenter Server instance, you must install a new Site Recovery Manager Server.
If you are updating an existing Site Recovery Manager 6.1 release to an update release or a patch release, not all of the steps in the procedure apply.

Prerequisites

- You completed the tasks and obtained the information described in Prerequisites and Best Practices for Site Recovery Manager Upgrade.
- Log in to the Site Recovery Manager host machine to upgrade. Log in using an account with sufficient privileges. This is often an Active Directory domain administrator, but can also be a local administrator.
- If you use an SQL Server database with Integrated Windows Authentication as the Site Recovery Manager database, use the same user account or an account with the same privileges when you upgrade Site Recovery Manager Server as you used when you created the Integrated Windows Authentication data source name (DSN) for SQL Server.

Procedure

1. Double-click the Site Recovery Manager installer, select an installation language, and click OK.
2. Follow the installer prompts to accept the license agreement, and verify that you satisfied the installation prerequisites.
3. Verify or modify the information about the Platform Services Controller at the site where you are upgrading Site Recovery Manager Server, enter the vCenter Single Sign-On password, and click Next.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
</table>
| Address      | The host name or IP address of the Platform Services Controller for the vCenter Server with which to register Site Recovery Manager. If the address of the Platform Services Controller changed during the upgrade of vCenter Server, enter the new address. Enter the host name in lowercase letters. After installation is complete and you are configuring the connection between the protected and recovery sites, supply this host name or IP address exactly as you enter it here, because it is subject to case-sensitive comparisons.  

**Important** To facilitate IP address changes in your infrastructure, provide a fully qualified domain name (FQDN) whenever possible, rather than an IP address.  

**Important** If the Platform Services Controller uses an FQDN rather than an IP address, you must specify the FQDN when you install Site Recovery Manager. |
| HTTPS Port   | Accept the default value of 443 or enter a new value if Platform Services Controller uses a different port. Platform Services Controller only supports connections over HTTPS and does not support HTTP connections. |
Option | Description
--- | ---
Username | The vCenter Single Sign-On user name for the vCenter Single Sign-On domain to which this Platform Services Controller instance belongs. This user account must be a member of the vCenter Single Sign-On Administrator group on the Platform Services Controller instance. Only members of the Administrator group have the necessary permissions to create or recreate the Site Recovery Manager solution user.

Password | The password for the specified vCenter Single Sign-On user name. The password text box can be empty.

4 If prompted, verify the Platform Services Controller certificate and click **Accept** to accept it.

5 Verify the vCenter Server instance with which the Site Recovery Manager Server instance to upgrade is registered, and click **Next**.

You cannot change the vCenter Server instance that Site Recovery Manager extends during upgrade.

6 Verify the Administrator E-mail, Local Host, and Listener Port values and click **Next**.

7 Select a certificate type and click **Next**.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
</table>
| Automatically generate certificate | Use an automatically generated certificate: 
  a Select **Automatically generate certificate** and click **Next**. 
  b Enter text values for your organization and organization unit, typically your company name and the name of your group in the company. 
  c Click **Next**. |

Load a certificate file | Use a custom certificate: 
  a Select **Use a PKCS#12 certificate file** and click **Next**. 
  b Click **Browse**, navigate to the certificate file, and click **Open**. The certificate file must contain exactly one certificate with exactly one private key matching the certificate. 
  c Enter the certificate password. 
  d Click **Next**. |

Use existing certificate | Select this option to retain the current certificate.

8 Enter the password for the Site Recovery Manager database, and click **Next**.

9 Select the user account under which to run the Site Recovery Manager Server service and click **Next**.

- Select **Use Local System Account** to run the Site Recovery Manager Server service under the Local System account.

- Enter the username and password of an existing LDAP user account to run the Site Recovery Manager Server service under a different user account. This can be any user account, including local users, that is a member of the built-in Administrators group.

This option is not available if you use an SQL Server database with Integrated Windows Authentication. In this case, the Site Recovery Manager Server service runs under the account that you use to install Site Recovery Manager.

10 Click **Install**.
When the installation is finished, click **Finish**.

**What to do next**

- Log in to vSphere Web Client, or if you are already connected to vSphere Web Client, log out of vSphere Web Client and log in again. The upgraded Site Recovery Manager extension appears in vSphere Web Client. You might need to clear the browser cache for the upgrade to appear in vSphere Web Client. If the upgrade still does not appear, restart the vSphere Web Client service.

- Select **Site Recovery > Sites > Site > Summary** in the vSphere Web Client to verify that the build numbers for Site Recovery Manager Server and the Site Recovery Manager plugin reflect the upgrade.

- Repeat the procedure to upgrade the Site Recovery Manager Server on the other Site Recovery Manager site.

- If you changed the Platform Services Controller address, or you changed the Site Recovery Manager, Platform Services Controller, or vCenter Server certificate during the upgrade, or if the site pairing is broken, reconfigure the pairing between the sites. For information about site pairing, see [Reconfigure the Connection Between Sites](#).

- When you have upgraded both sites, perform the post-upgrade tasks in [Configure and Verify the Upgraded Site Recovery Manager Installation](#).

**Upgrade Site Recovery Manager Server with Migration**

You can upgrade Site Recovery Manager and migrate Site Recovery Manager Server to a different host than the previous Site Recovery Manager Server installation.

To upgrade Site Recovery Manager and migrate Site Recovery Manager Server to a different host, you create a new Site Recovery Manager Server installation on the new host, and connect it to the Site Recovery Manager database from the previous installation.

**Important** Do not uninstall the old Site Recovery Manager Server installation after you complete the upgrade. If you uninstall the old Site Recovery Manager Server installation, this will unregister the new installation from vCenter Server.

You can only upgrade Site Recovery Manager with migration if you use an external database with the previous installation. You cannot migrate the contents of the embedded database.

To upgrade Site Recovery Manager and keep Site Recovery Manager Server on the same host as the previous installation, see [In-Place Upgrade of Site Recovery Manager Server](#).

**Important** You cannot perform upgrade with migration if you are updating Site Recovery Manager 6.1 to a 6.1.x update release or to a 6.1.0.x patch release. To upgrade Site Recovery Manager 6.1 to a 6.1.x update release or to a 6.1.0.x patch release, see [In-Place Upgrade of Site Recovery Manager Server](#).
Prerequisites

- You completed the tasks and obtained the information described in Prerequisites and Best Practices for Site Recovery Manager Upgrade.
- Log in to the host machine on which the previous version of Site Recovery Manager Server is running. Log in using an account with sufficient privileges. This is often an Active Directory domain administrator, but can also be local administrator.
- Log in to the host machine on which to install the new version of Site Recovery Manager Server. Log in using an account with sufficient privileges. This is often an Active Directory domain administrator, but can also be local administrator.
- Create a 64-bit ODBC system data source name (DSN) on the new host machine to connect to the existing Site Recovery Manager database that you used with the previous version. For information about creating an ODBC DSN, see Create an ODBC System DSN for Site Recovery Manager.
- If you use an SQL Server database with Integrated Windows Authentication as the Site Recovery Manager database, you must use the same user account or an account with the same privileges when you upgrade Site Recovery Manager Server as you used when you created the Integrated Windows Authentication DSN for SQL Server.

Procedure

1. Stop the Site Recovery Manager Server service on the old Site Recovery Manager Server host.
2. On the host on which to install the new version of Site Recovery Manager Server, double-click the Site Recovery Manager installer, select an installation language, and click OK.
3. Follow the installer prompts to accept the license agreement, and verify that you satisfied the installation prerequisites.
4. Choose where to install Site Recovery Manager Server, and click Next.
   - Keep the default destination folder.
   - Click Change to change the destination folder, and select a target volume.
   The default installation folder for Site Recovery Manager is C:\Program Files\VMware\VMware vCenter Site Recovery Manager. If you use a different folder, the pathname cannot be longer than 120 characters including the end slash, and cannot include non-ASCII characters.
5. Enter information about the Platform Services Controller at the site where you are upgrading Site Recovery Manager Server and click **Next**.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Address</td>
<td>The host name or IP address of the Platform Services Controller for the vCenter Server with which to register Site Recovery Manager. Enter the host name in lowercase letters. After installation is complete and you are configuring the connection between the protected and recovery sites, supply this host name or IP address exactly as you enter it here, because it is subject to case-sensitive comparisons.</td>
</tr>
<tr>
<td></td>
<td><strong>Important</strong> To facilitate IP address changes in your infrastructure, provide a fully qualified domain name (FQDN) whenever possible, rather than an IP address.</td>
</tr>
<tr>
<td></td>
<td><strong>Important</strong> If the Platform Services Controller uses an FQDN rather than an IP address, you must specify the FQDN when you install Site Recovery Manager.</td>
</tr>
<tr>
<td>HTTPS Port</td>
<td>Accept the default value of 443 or enter a new value if Platform Services Controller uses a different port. Platform Services Controller only supports connections over HTTPS and does not support HTTP connections.</td>
</tr>
<tr>
<td>Username</td>
<td>The vCenter Single Sign-On user name for the vCenter Single Sign-On domain to which this Platform Services Controller instance belongs. This user account must be a member of the vCenter Single Sign-On Administrator group on the Platform Services Controller instance. Only members of the Administrator group have the necessary permissions to create or recreate the Site Recovery Manager solution user.</td>
</tr>
<tr>
<td>Password</td>
<td>The password for the specified vCenter Single Sign-On user name. The password text box can be empty.</td>
</tr>
</tbody>
</table>

6. If prompted, verify the Platform Services Controller certificate and click **Accept** to accept it.

7. Select the vCenter Server instance with which to register Site Recovery Manager and click **Next**.

   **Important** The drop-down menu includes all of the vCenter Server instances that are registered with the Platform Services Controller. In an environment that uses Enhanced Linked Mode, it can also include vCenter Server instances from other Platform Services Controller instances. Make sure that you select the correct vCenter Server instance. Once the Site Recovery Manager installation is complete, you cannot modify it to select a different vCenter Server instance.

8. Enter information with which to register the Site Recovery Manager extension with vCenter Server, and click **Next**.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Local Site Name</td>
<td>A name for this Site Recovery Manager site, that appears in the Site Recovery Manager interface. The vCenter Server address is used by default, but you can enter any name. You cannot use the same name that you use for another Site Recovery Manager installation with which this one will be paired.</td>
</tr>
<tr>
<td>Administrator E-mail</td>
<td>Email address of the Site Recovery Manager administrator. This information is required even though you use the standard vCenter Server alarms to configure email notifications for Site Recovery Manager events.</td>
</tr>
<tr>
<td>Option</td>
<td>Description</td>
</tr>
<tr>
<td>-------------------------</td>
<td>------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Local Host</td>
<td>Name or IP address of the local host. The Site Recovery Manager installer obtains this value. Only change it if it is incorrect. For example, the local host might have more than one network interface and the one that the Site Recovery Manager installer detects is not the interface you want to use. <strong>Important</strong> To facilitate IP address changes in your infrastructure, provide a fully qualified domain name (FQDN) whenever possible, rather than an IP address.</td>
</tr>
<tr>
<td>Listener Port</td>
<td>HTTPS port for all management traffic to Site Recovery Manager Server, including traffic with external API clients for task automation. The port is also used by vSphere Web Client to download the Site Recovery Manager client plugin. This port must be accessible from the vCenter Server proxy system. Do not change the port unless the default of 9086 causes port conflicts.</td>
</tr>
</tbody>
</table>

9 Select the default Site Recovery Manager plug-in identifier, or create a plug-in identifier for this Site Recovery Manager Server pair, and click **Next**.

Both Site Recovery Manager Server instances in a site pair must use the same plug-in identifier.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Default SRM Plug-in Identifier</td>
<td>Use this option when you install Site Recovery Manager in a standard configuration with one protected site and one recovery site.</td>
</tr>
<tr>
<td>Custom SRM Plug-in Identifier</td>
<td>Use this option when you install Site Recovery Manager in a shared recovery site configuration, with multiple protected sites and one recovery site. Enter the details of the plug-in identifier.</td>
</tr>
<tr>
<td><strong>Plug-in ID</strong></td>
<td>A unique identifier. Assign the same identifier to the Site Recovery Manager Server instances on the protected site and the shared recovery site.</td>
</tr>
<tr>
<td><strong>Organization</strong></td>
<td>The name of the organization to which this Site Recovery Manager Server pair belongs. This name helps to identify to Site Recovery Manager Server pairs in a shared recovery site configuration, especially when multiple organizations use the shared recovery site.</td>
</tr>
<tr>
<td><strong>Description</strong></td>
<td>An optional description of this Site Recovery Manager Server pair.</td>
</tr>
</tbody>
</table>

10 Click **Yes** to confirm that you want to overwrite the existing Site Recovery Manager extension on this vCenter Server instance.
11 Select a certificate type and click **Next**.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
</table>
| Automatically generate certificate | Use an automatically generated certificate:  
  a Select **Automatically generate certificate** and click **Next**.  
  b Enter text values for your organization and organization unit, typically your company name and the name of your group in the company.  
  c Click **Next**.  
| Load a certificate file       | Use a custom certificate:  
  a Select **Use a PKCS#12 certificate file** and click **Next**.  
  b Click **Browse**, navigate to the certificate file, and click **Open**. The certificate file must contain exactly one certificate with exactly one private key matching the certificate.  
  c Enter the certificate password.  
  d Click **Next**. |

12 Select **Use a custom database server**, select the 64-bit DSN that connects to the Site Recovery Manager database that you used with the previous installation, click **Next**, and provide the database connection information.

<table>
<thead>
<tr>
<th>Option</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>Username</td>
<td>Enter a valid user name for the specified database. If you use Integrated Windows Authentication, this option is not available.</td>
</tr>
<tr>
<td>Password</td>
<td>Enter the password for the specified user name. If you use Integrated Windows Authentication, this option is not available.</td>
</tr>
<tr>
<td>Connection Count</td>
<td>Enter the initial connection pool size. In most cases, it is not necessary to change this setting. Before changing this setting, consult with your database administrator.</td>
</tr>
<tr>
<td>Max Connections</td>
<td>Enter the maximum number of database connections that can be open simultaneously. In most cases, it is not necessary to change this setting. Before changing this setting consult with your database administrator.</td>
</tr>
</tbody>
</table>

13 Select the user account under which to run the Site Recovery Manager Server service and click **Next**.

- Select **Use Local System Account** to run the Site Recovery Manager Server service under the Local System account.

- Enter the username and password of an existing LDAP user account to run the Site Recovery Manager Server service under a different user account. This can be any user account, including local users, that is a member of the built-in Administrators group. This option is not available if you use an SQL Server database with Integrated Windows Authentication. In this case, the Site Recovery Manager Server service runs under the account that you use to install Site Recovery Manager.

14 Click **Install**.

15 When the installation is finished, click **Finish**.
What to do next

- Log in to vSphere Web Client, or if you are already connected to vSphere Web Client, log out of vSphere Web Client and log in again. The upgraded Site Recovery Manager extension appears in vSphere Web Client. You might need to clear the browser cache for the upgrade to appear in vSphere Web Client. If the upgrade still does not appear, restart the vSphere Web Client service.
- Repeat the procedure to upgrade the Site Recovery Manager Server on the other Site Recovery Manager site.
- When you have upgraded both sites, perform the post-upgrade tasks in Configure and Verify the Upgraded Site Recovery Manager Installation.

Configure and Verify the Upgraded Site Recovery Manager Installation

You must configure the upgraded components to establish a working Site Recovery Manager installation.

If you use array-based replication, you must check that your storage replication adapters (SRAs) are compatible with this version of Site Recovery Manager. Depending on the type of storage that you use, you might need to reinstall the SRAs.

If you use vSphere Replication and you upgraded vSphere Replication to the correct version, no additional configuration is required other than verifying your connections, protection groups, and recovery plans.

Prerequisites

- You upgraded vCenter Server and Site Recovery Manager.
- Download the SRA by going to https://my.vmware.com/web/vmware/downloads, selecting VMware vCenter Site Recovery Manager > Download Product, then selecting Drivers & Tools > Storage Replication Adapters > Go to Downloads.
- If you obtain an SRA from a different vendor site, verify that it has been certified for the Site Recovery Manager release you are using by checking the VMware Compatibility Guide for Site Recovery Manager at http://www.vmware.com/resources/compatibility/search.php?deviceCategory=sra.
- Connect to the vSphere Web Client on both of the sites.

Procedure

1. In the vSphere Web Client client, select Site Recovery > Sites, right-click a site and select Reconfigure Pairing to reconfigure the connection between the Site Recovery Manager sites.
2. If you use array-based replication, select Site Recovery > Array Based Replication and check the status of the array pairs.
3 If array managers are in the Error state, uninstall the SRAs, install the new version, and rescan the SRAs on the Site Recovery Manager Server hosts that you upgraded.

You must perform these tasks on both sites.

   a Log in to the Site Recovery Manager Server host machine on each site.
   b Uninstall the SRAs that are in the Error state.
   c Reinstall the SRAs with the SRA version that corresponds to this version of Site Recovery Manager.
   d In the vSphere Web Client client for each site, select Site Recovery > Sites, right-click a site and select Rescan SRAs.

4 If you use array-based replication, reenter the login credentials for the array managers.

   a Select Site Recovery > Array Based Replication, right-click an array manager and select Edit Array Manager.
   b Follow the prompts to the Configure array manager page, and enter the username and password for the array.
   c Follow the prompts to complete the reconfiguration of the array manager.

5 Select Site Recovery > Protection Groups and Site Recovery > Recovery Plans and verify that your protection groups and recovery plans from the previous version are present.

6 In Site Recovery > Recovery Plans, run a test on each of your recovery plans.

**Revert to a Previous Release of Site Recovery Manager**

To revert to a previous release of Site Recovery Manager, you must uninstall Site Recovery Manager from the protected and recovery sites. You can then reinstall the previous release.

**Prerequisites**

- Verify that your installation of vCenter Server supports the Site Recovery Manager release that you are reverting to. For information about the vCenter Server releases that support other versions of Site Recovery Manager, see the *Compatibility Matrixes for Site Recovery Manager 6.1* at https://www.vmware.com/support/srm/srm-compat-matrix-6-1.html. For information about reverting a vCenter Server installation, see the vSphere documentation.

- Verify that you made a backup of the Site Recovery Manager database before you upgraded Site Recovery Manager from a previous release to this release. For information about how to back up the embedded database, see Back Up and Restore the Embedded vPostgres Database.
Procedure

1  Use the Windows Control Panel options to uninstall Site Recovery Manager at the protected and recovery sites.

   If you connected the Site Recovery Manager Server instances at the protected and recovery sites, you must uninstall Site Recovery Manager at both sites. If you uninstall Site Recovery Manager from one side of a site pairing but not the other, the database on the remaining site becomes inconsistent.

2  Restore the Site Recovery Manager database from the backup that you made when you upgraded Site Recovery Manager from the previous release.

   You must restore the database on both sites so they are synchronized. For instructions about how to restore a database from a backup, see the documentation from your database vendor.

3  Install the previous release of Site Recovery Manager Server on the protected and recovery sites.

4  Reestablish the connection between the Site Recovery Manager Server instances on the protected and recovery sites.

If you restored a backup of the Site Recovery Manager database from the previous version, any configurations or protection plans that you created before you upgraded Site Recovery Manager are retained.
Installing Site Recovery Manager to Use with a Shared Recovery Site

With Site Recovery Manager, you can connect multiple protected sites to a single recovery site. The virtual machines on the protected sites all recover to the same recovery site. This configuration is known as a shared recovery site, a many-to-one, fan-in, or an N:1 configuration.

In the standard one-to-one Site Recovery Manager configuration, you use Site Recovery Manager to protect a specific instance of vCenter Server by pairing it with another vCenter Server instance. The first vCenter Server instance, the protected site, recovers virtual machines to the second vCenter Server instance, the recovery site.

Another example is to have multiple protected sites that you configure to recover to a single, shared recovery site. For example, an organization can provide a single recovery site with which multiple protected sites for remote field offices can connect. Another example for a shared recovery site is for a service provider that offers business continuity services to multiple customers.

In a shared recovery site configuration, you install one Site Recovery Manager Server instance on each protected site, each of which connects to a different vCenter Server instance. On the recovery site, you install multiple Site Recovery Manager Server instances to pair with each Site Recovery Manager Server instance on the protected sites. All of the Site Recovery Manager Server instances on the shared recovery site connect to a single vCenter Server instance. Each Site Recovery Manager Server instance in a pair must have the same Site Recovery Manager extension ID, which you can set when you install Site Recovery Manager Server. You can consider the owner of a Site Recovery Manager Server pair to be a customer of the shared recovery site.

You can convert an existing one-to-one configuration of Site Recovery Manager into a shared recovery site configuration. To convert a one-to-one configuration to a shared recovery site configuration, you deploy additional Site Recovery Manager Server and vCenter Server instances as protected sites, and pair them with additional Site Recovery Manager Server instances that all connect to the existing vCenter Server instance on the recovery site. Each pair of Site Recovery Manager Server instances in the shared recovery site configuration must use a different Site Recovery Manager extension ID. For example, if you installed a one-to-one configuration that uses the default Site Recovery Manager extension ID, you must deploy all subsequent Site Recovery Manager Server pairs with different custom extension IDs.

You can use either array-based replication or vSphere Replication or a combination of both when you configure Site Recovery Manager Server to use a shared recovery site.
In addition to the shared recovery site configuration, Site Recovery Manager also allows and supports shared protected site (one-to-many, fan-out, or 1:N) and many-to-many (N:N) configurations.

**Example: Using Site Recovery Manager with Multiple Protected Sites and a Shared Recovery Site**

An organization has two field offices and a head office. Each of the field offices is a protected site. The head office acts as the recovery site for both of the field offices. Each field office has a Site Recovery Manager Server instance and a vCenter Server instance. The head office has two Site Recovery Manager Server instances, each of which is paired with a Site Recovery Manager Server instance in one of the field offices. Both of the Site Recovery Manager Server instances at the head office extend a single vCenter Server instance.

- **Field office 1**
  - Site Recovery Manager Server A
  - vCenter Server A
- **Field office 2**
  - Site Recovery Manager Server B
  - vCenter Server B
- **Head office**
  - Site Recovery Manager Server C, that is paired with Site Recovery Manager Server A
  - Site Recovery Manager Server D, that is paired with Site Recovery Manager Server B
  - vCenter Server C, that is extended by Site Recovery Manager Server C and Site Recovery Manager Server D
This section includes the following topics:

- Shared Recovery Sites and vCenter Server Deployment Models
- Limitations of Using Site Recovery Manager in Shared Recovery Site Configuration
- Site Recovery Manager Licenses in a Shared Recovery Site Configuration
- Install Site Recovery Manager In a Shared Recovery Site Configuration
- Upgrade Site Recovery Manager in a Shared Recovery Site Configuration

**Shared Recovery Sites and vCenter Server Deployment Models**

You can use Site Recovery Manager in a shared recovery site configuration in any of the deployment models that vCenter Server supports.

For information about how the vCenter Server deployment model affects Site Recovery Manager, see Site Recovery Manager and vCenter Server Deployment Models.
Site Recovery Manager in a Shared Recovery Site Configuration

In a shared recovery site configuration, the Site Recovery Manager Server instances on the recovery site connect to the same vCenter Server and Platform Services Controller instances.

The Site Recovery Manager Server instances on the protected sites can connect to vCenter Server instances that share a Platform Services Controller or that each connect to a different Platform Services Controller.

Figure 9-2 shows one possible shared recovery site configuration. In this example, the Site Recovery Manager Server instances on the protected sites connect to a single Platform Services Controller instance that two vCenter Server instances share.

Site Recovery Manager in a Shared Protected Site Configuration

In a shared protected site configuration, the Site Recovery Manager Server instances on the protected site connect to the same vCenter Server and Platform Services Controller instances.

The Site Recovery Manager Server instances on the recovery sites can share vCenter Server and Platform Services Controller instances, or they can connect to a different vCenter Server and Platform Services Controller instances.
Figure 9-3 shows one possible shared protected site configuration. In this example, two Site Recovery Manager Server instances share a vCenter Server instance on each of two shared protected sites. The vCenter Server instances on both of the shared protected sites share a single Platform Services Controller. On the recovery sites, two Site Recovery Manager Server instances share a vCenter Server instance on each shared recovery site. The vCenter Server instances on both of the shared recovery sites share a single Platform Services Controller.

**Figure 9-3. Site Recovery Manager in a Shared Protected Site and Shared Recovery Site Configuration**

**Limitations of Using Site Recovery Manager in Shared Recovery Site Configuration**

When you configure Site Recovery Manager to use a shared recovery site, Site Recovery Manager supports the same operations as it does in a standard one-to-one configuration. Using Site Recovery Manager with a shared recovery site is subject to some limitations.

- Site Recovery Manager supports point-to-point replication. Site Recovery Manager does not support replication to multiple targets, even in a multi-site configuration.
- For each shared recovery site customer, you must install Site Recovery Manager Server once at the customer site and again at the recovery site.
You must specify the same Site Recovery Manager extension ID when you install the Site Recovery Manager Server instances on the protected site and on the shared recovery site. For example, you can install the first pair of sites with the default Site Recovery Manager extension ID, then install subsequent pairs of sites with custom extension IDs.

You must install each Site Recovery Manager Server instance at the shared recovery site on its own host machine. You cannot install multiple instances of Site Recovery Manager Server on the same host machine.

Each Site Recovery Manager Server instance on the protected site and on the shared recovery site requires its own database.

A single shared recovery site can support a maximum of ten protected sites. You can run concurrent recoveries from multiple sites. See http://kb.vmware.com/kb/2119336 for the number of concurrent recoveries that you can run with array-based replication and with vSphere Replication.

In a large Site Recovery Manager environment, you might experience timeout errors when powering on virtual machines on a shared recovery site. See Timeout Errors when Powering on Virtual Machines on a Shared Recovery Site.

When connecting to Site Recovery Manager on the shared recovery site, every customer can see all of the Site Recovery Manager extensions that are registered with the shared recovery site, including company names and descriptions. All customers of a shared recovery site can have access to other customers' folders and potentially to other information at the shared recovery site. For information about permissions in a shared recovery site setup, see Managing Permissions in a Shared Recovery Site Configuration in Site Recovery Manager Administration.

**Timeout Errors when Powering on Virtual Machines on a Shared Recovery Site**

In a large Site Recovery Manager environment, you might encounter timeout errors when powering on virtual machines on a shared recovery site.

**Problem**

When you power on virtual machines on a shared recovery site, you see the error message `Error:Operation timed out:900 seconds`.

**Cause**

This problem can occur if a single vCenter Server instance manages a large number of virtual machines on the shared recovery site, for example 1000 or more.

**Solution**

1. Increase the `remoteManager.defaultTimeout` timeout value on the Site Recovery Manager Server on the recovery site.

   For example, increase the timeout from the default of 300 seconds to 1200 seconds. For information about how to increase the `remoteManager.defaultTimeout` setting, see Change Remote Manager Settings in Site Recovery Manager Administration.
Go to C:\Program Files\VMware\VMware vCenter Site Recovery Manager\config on the Site Recovery Manager Server host machine on the recovery site.

Open vmware-dr.xml in a text editor.

Set the timeout for reading from the vSphere Web Client.

Set the timeout to 900 seconds (15 minutes) by adding a line to the <vmacore><http> element.

```xml
<vmacore>
  <http>
    <defaultClientReadTimeoutSeconds>900</defaultClientReadTimeoutSeconds>
  </http>
</vmacore>
```

Restart the Site Recovery Manager Server service.

**What to do next**

If you still experience timeouts after increasing the RemoteManager timeout value, experiment with progressively longer timeout settings. Do not increase the timeout period excessively. Setting the timeout to an unrealistically long period can hide other problems, for example problems related to communication between Site Recovery Manager Server and vCenter Server or other services that Site Recovery Manager requires.

**Site Recovery Manager Licenses in a Shared Recovery Site Configuration**

If you configure Site Recovery Manager to use with a shared recovery site, you can assign licenses individually on the shared recovery site. You can also share a license between all Site Recovery Manager Server instances on the shared recovery site.

In a shared recovery site configuration, you install Site Recovery Manager license keys on each of the protected sites to enable recovery. You can install the same license key on the shared recovery site and assign it to the partner Site Recovery Manager Server instance to enable bidirectional operation, including reprotect. You can use the same license key for both Site Recovery Manager Server instances in the Site Recovery Manager pair, in the same way as for a one-to-one configuration.

Alternatively, you can install one Site Recovery Manager license key on the shared recovery site. All Site Recovery Manager Server instances on the shared recovery site share this license. In this configuration, you must ensure that you have sufficient licenses for the total number of virtual machines that you protect on the shared recovery site, for all protected sites.
Example: Sharing Site Recovery Manager Licenses on a Shared Recovery Site

You connect two protected sites to a shared recovery site. You install a single Site Recovery Manager license on the shared recovery site.

- If you protect 20 virtual machines on protected site A, you require a license for 20 virtual machines on protected site A to recover these virtual machines to the shared recovery site.

- If you protect 10 virtual machines on protected site B, you require a license for 10 virtual machines on protected site B to recover these virtual machines to the shared recovery site.

- You share a Site Recovery Manager license for 25 virtual machines between two Site Recovery Manager Server instances, C and D, on the shared recovery site. The Site Recovery Manager Server instances on sites A and B connect to Site Recovery Manager Server instances C and D respectively.

Because you have a license for 25 virtual machines on the shared recovery site, the total number of virtual machines for which you can perform reprotect after a recovery is 25. If you recover all of the virtual machines from sites A and B to the shared recovery site and attempt to perform reprotect, you have sufficient licenses to reprotect only 25 of the 30 virtual machines that you recovered. You can reprotect all 20 of the virtual machines from site A to reverse protection from Site Recovery Manager Server C to site A. You can reprotect only 5 of the virtual machines to reverse protection from Site Recovery Manager Server D to site B.

In this situation, you can purchase licenses for more virtual machines for the shared recovery site. Alternatively, you can add the license keys from sites A and B to vCenter Server on the shared recovery site, and assign the license from site A to Site Recovery Manager Server C and the license from site B to Site Recovery Manager Server D.

Install Site Recovery Manager In a Shared Recovery Site Configuration

To install Site Recovery Manager in a shared recovery site configuration, you deploy Site Recovery Manager Server on one or more protected sites, and deploy a corresponding number of Site Recovery Manager Server instances on the shared recovery site.

You can only pair protected and recovery sites that have the same Site Recovery Manager extension ID.

Procedure

1. Use vSphere Replication in a Shared Recovery Site Configuration
   You can use vSphere Replication with Site Recovery Manager in a shared recovery site configuration in the same way that you do in a standard one-to-one configuration.

2. Install Site Recovery Manager Server on Multiple Protected Sites to Use with a Shared Recovery Site
   You install Site Recovery Manager Server to use with a shared recovery site by running the Site Recovery Manager installer and specifying a Site Recovery Manager ID for the site pair.
3 **Install Multiple Site Recovery Manager Server Instances on a Shared Recovery Site**

In a shared recovery site configuration, you can install multiple Site Recovery Manager Server instances that all extend the same vCenter Server instance on the shared recovery site.

4 **Connect the Site Recovery Manager Sites in a Shared Recovery Site Configuration**

In a shared recovery site configuration, you connect the Site Recovery Manager sites in the same way as for a standard one-to-one configuration.

5 **Use Array-Based Replication in a Shared Recovery Site Configuration**

You can use array-based replication with Site Recovery Manager in a shared recovery site configuration in the same way as you do in a standard one-to-one configuration.

6 **Configure Placeholders and Mappings in a Shared Recovery Site Configuration**

When you configure placeholders and mappings in a shared recovery site configuration, the customers of the shared recovery site can share the resources on the recovery site. Alternatively, you can assign isolated resources to each customer.

### Use vSphere Replication in a Shared Recovery Site Configuration

You can use vSphere Replication with Site Recovery Manager in a shared recovery site configuration in the same way that you do in a standard one-to-one configuration.

You deploy one vSphere Replication appliance on each protected site. You deploy only one vSphere Replication appliance on the shared recovery site. All of the vSphere Replication appliances on the protected sites connect to this single vSphere Replication appliance on the recovery site. You deploy the vSphere Replication appliances in the same way as for a standard one-to-one configuration.

**Important** Deploy only one vSphere Replication appliance on the shared recovery site. If you deploy multiple vSphere Replication appliances on the shared recovery site, each new vSphere Replication appliance overwrites the registration of the previous vSphere Replication appliance with vCenter Server. This overwrites all existing replications and configurations.

You can deploy multiple additional vSphere Replication servers on the shared recovery site to distribute the replication load. For example, you can deploy on the shared recovery site a vSphere Replication server for each of the protected sites that connects to the shared recovery site. For information about protection and recovery limits when using vSphere Replication with Site Recovery Manager in a shared recovery site configuration, see [http://kb.vmware.com/kb/2119336](http://kb.vmware.com/kb/2119336).

**Prerequisites**

- To use Site Recovery Manager with vSphere Replication, deploy the appropriate version of vSphere Replication on both of the protected and recovery sites before you install Site Recovery Manager Server. The Site Recovery Manager installer verifies the version of vSphere Replication during installation and stops if it detects an incompatible version. This verification is not performed if you install vSphere Replication after you install Site Recovery Manager Server, which might lead to incompatible versions. Incompatible versions of Site Recovery Manager and...
vSphere Replication cause the vSphere Web Client to stop working. For information about compatibility between vSphere Replication and Site Recovery Manager versions, see vSphere Replication Requirements in the Compatibility Matrixes for Site Recovery Manager 6.1 at https://www.vmware.com/support/srm/srm-compat-matrix-6-1.html.

- If you have existing vSphere Replication appliances on the sites, you must either upgrade them to the correct version or unregister them from both vCenter Server instances before you install Site Recovery Manager. For instructions about unregistering vSphere Replication, see Unregister an Incompatible Version of vSphere Replication.

Procedure

1. Deploy a vSphere Replication appliance on each of the protected sites.
2. Deploy one vSphere Replication appliance on the shared recovery site.
3. (Optional) Deploy additional vSphere Replication servers on the shared recovery site.
4. (Optional) Register the additional vSphere Replication servers with the vSphere Replication appliance on the shared recovery site.

The vSphere Replication servers become available to all Site Recovery Manager instances on the shared recovery site.

The shared recovery site is ready to receive replicated virtual machines that you recover from the protected sites by using vSphere Replication.

Install Site Recovery Manager Server on Multiple Protected Sites to Use with a Shared Recovery Site

You install Site Recovery Manager Server to use with a shared recovery site by running the Site Recovery Manager installer and specifying a Site Recovery Manager ID for the site pair.

For each protected site, you must install one instance of Site Recovery Manager Server at the protected site and one instance of Site Recovery Manager Server at the recovery site. You can only pair Site Recovery Manager Server instances that have the same Site Recovery Manager extension ID. Each protected site must include its own vCenter Server instance. You can connect up to 10 protected sites to a single recovery site.

Prerequisites

- Download the Site Recovery Manager installation file to a folder on the Site Recovery Manager Server host.

- This information presumes knowledge of the standard procedure for installing Site Recovery Manager. See Install Site Recovery Manager Server for information about a standard Site Recovery Manager installation.

Procedure

1. Double-click the Site Recovery Manager installer, select an installation language, and click OK.
2 Follow the prompts to begin the Site Recovery Manager installation.

3 At the SRM Plug-in ID page, select **Custom SRM Plug-in Identifier**, provide information to identify this custom Site Recovery Manager extension, and click **Next**.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>SRM ID</td>
<td>Enter a unique identifier for this pair of Site Recovery Manager Server instances. The Site Recovery Manager ID can be a string of up to 29 ASCII characters from the set of ASCII upper- lower-case characters, digits, the underscore, the period, and the hyphen. You cannot use the underscore, period, and hyphen as the first or last characters of the Site Recovery Manager ID, and they cannot appear adjacent to one another.</td>
</tr>
<tr>
<td>Organization</td>
<td>Enter a string of up to 50 ASCII characters to specify the organization that created the extension.</td>
</tr>
<tr>
<td>Description</td>
<td>Enter a string of up to 50 ASCII characters to provide a description of the extension.</td>
</tr>
</tbody>
</table>

4 Follow the prompts to complete the remainder of the installation.

5 Repeat the procedure on each of the sites to protect.

   Connect each Site Recovery Manager Server to its own vCenter Server instance. Assign a unique Site Recovery Manager ID to each Site Recovery Manager Server.

**What to do next**

For each Site Recovery Manager Server that you installed on a protected site, install a corresponding Site Recovery Manager Server instance on the shared recovery site.

**Install Multiple Site Recovery Manager Server Instances on a Shared Recovery Site**

In a shared recovery site configuration, you can install multiple Site Recovery Manager Server instances that all extend the same vCenter Server instance on the shared recovery site.

The Site Recovery Manager Server instances that you install on a shared recovery site each correspond to a Site Recovery Manager Server on a protected site.

**Prerequisites**

- You created one or more protected sites, each with a Site Recovery Manager Server instance for which you configured a unique Site Recovery Manager plug-in ID. Click **Site Recovery > Sites** in the vSphere Web Client, select a site and click **Summary** to check the Site Recovery Manager plug-in ID of the Site Recovery Manager instance to which you are connecting this instance.
- Download the Site Recovery Manager installation file to a folder on the Site Recovery Manager Server host.
- This information presumes knowledge of the standard procedure for installing Site Recovery Manager. See **Install Site Recovery Manager Server** for information about a standard Site Recovery Manager installation.
Procedure

1. Double-click the Site Recovery Manager installer, select an installation language, and click OK.

2. Follow the prompts to begin the Site Recovery Manager installation.

3. At the SRM Plug-in ID page, select Custom SRM Plug-in Identifier, provide information to identify this Site Recovery Manager extension as the partner of a Site Recovery Manager Server instance on a protected site, and click Next.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>SRM ID</td>
<td>Enter the same Site Recovery Manager ID as you provided for the corresponding Site Recovery Manager Server instance on the protected site. For example, if you set the Site Recovery Manager ID of the Site Recovery Manager Server instance on the protected site to SRM-01, set the Site Recovery Manager ID to SRM-01.</td>
</tr>
<tr>
<td>Organization</td>
<td>Enter a string of up to 50 ASCII characters to specify the organization that created the extension.</td>
</tr>
<tr>
<td>Description</td>
<td>Enter a string of up to 50 ASCII characters to provide a description of the extension.</td>
</tr>
</tbody>
</table>

4. Follow the prompts to complete the remainder of the installation.

What to do next

Repeat the procedure to install further Site Recovery Manager Server instances on the shared recovery site, each with a Site Recovery Manager plug-in ID that matches a Site Recovery Manager Server instance on another protected site. Each additional Site Recovery Manager Server instance that you install on the recovery site connects to the vCenter Server instance. You can connect a maximum of 10 Site Recovery Manager Server instances to a single vCenter Server instance.

Connect the Site Recovery Manager Sites in a Shared Recovery Site Configuration

In a shared recovery site configuration, you connect the Site Recovery Manager sites in the same way as for a standard one-to-one configuration.

If you start the site connection from one of the protected sites, Site Recovery Manager uses the Site Recovery Manager ID that you set during installation to connect to the corresponding Site Recovery Manager Server instance on the recovery site.

If you start the site connection from one of the Site Recovery Manager Server instances on the shared recovery site, and you try to connect to a protected site that has a Site Recovery Manager Server extension with a different Site Recovery Manager ID, the connection fails with an error.

Prerequisites

- You installed Site Recovery Manager Server on one or more protected sites.
- You installed one or more Site Recovery Manager Server instances on a shared recovery site.
You assigned the same Site Recovery Manager extension ID to a Site Recovery Manager Server instance on a protected site and to a Site Recovery Manager Server instance on the shared recovery site.

**Procedure**

1. Connect to the vSphere Web Client for a site, click **Site Recovery > Sites**, and select a site.
2. Right-click the site and select **Pair Site**.
3. Enter the address of the Platform Services Controller for the Site Recovery Manager Server on the remote site, and click **Next**.

   The address that you provide for the Platform Services Controller must be an exact match of the address that you provided when you installed Site Recovery Manager Server on the remote site.

   **Important** To facilitate IP address changes in your infrastructure, provide a fully qualified domain name (FQDN) whenever possible, rather than an IP address.

4. Select the vCenter Server instance with which Site Recovery Manager Server is registered on the remote site, provide the vCenter Single Sign-On username and password, and click **Finish**.

   If several Site Recovery Manager Server instances are registered with this vCenter Server instance, Site Recovery Manager connects to the Site Recovery Manager Server instance that has the corresponding Site Recovery Manager ID.

5. Repeat Step 1 to Step 4 to configure the site pairing for all of the sites that use the shared recovery site.

6. (Optional) In the vSphere Web Client for the shared recovery site, click **Site Recovery > Sites**.

   All of the Site Recovery Manager Server instances that connect to vCenter Server on the shared recovery site appear in the list. All of the Site Recovery Manager Server instances on the protected sites that are paired with instances on the shared recovery site also appear.

7. (Optional) Select a site in the list and click the **Summary** tab to see information about the remote site that this site is paired with.

**Use Array-Based Replication in a Shared Recovery Site Configuration**

You can use array-based replication with Site Recovery Manager in a shared recovery site configuration in the same way as you do in a standard one-to-one configuration.

To use array-based replication with Site Recovery Manager in a shared recovery site configuration, you must install storage arrays and storage replication adapters (SRA) on each of the protected sites. Each protected site can use a different type of storage array.

Each protected site can either share the same storage on the shared recovery site, or you can allocate storage individually for each protected site. You can use storage from multiple vendors on the shared recovery site, as long as they correspond to storage that you use on the respective protected sites. You must install the appropriate SRA for each type of storage that you use on the shared recovery site.
For information about protection and recovery limits when you use array-based replication with Site Recovery Manager in a shared recovery site configuration, see http://kb.vmware.com/kb/2119336.

Prerequisites

- You installed Site Recovery Manager in a shared recovery site configuration.
- You connected the protected sites with the shared recovery site.

Procedure

1. Set up storage arrays on the protected sites following the instructions that your storage array provides.
2. Install the appropriate SRAs on Site Recovery Manager Server systems on the protected sites.
3. Install the appropriate SRAs on Site Recovery Manager Server systems on the shared recovery site.
4. Configure the array managers on the protected sites and on the shared recovery sites.
5. Configure the mappings from the resources on the protected sites to resources on the shared recovery site and configure the placeholder datastores.

The shared recovery site is ready to receive replicated virtual machines that you recover from the protected sites by using array-based replication.

Configure Placeholders and Mappings in a Shared Recovery Site Configuration

When you configure placeholders and mappings in a shared recovery site configuration, the customers of the shared recovery site can share the resources on the recovery site. Alternatively, you can assign isolated resources to each customer.

On a shared recovery site, multiple customers share a single vCenter Server instance. In some cases, multiple customers can share a single ESXi host on the recovery site. You can map the resources on the protected sites to shared resources on the shared recovery site. You might share resources on the recovery site if you do not need to keep all of the customers' virtual machines separate, for example if all of the customers belong to the same organization.

You can also create isolated resources on the shared recovery site and map the resources on the protected sites to their own dedicated resources on the shared recovery site. You might use this configuration if you must keep all of the customers' virtual machines separate from each other, for example if all of the customers belong to different organizations.

For information about how to assign permissions to allow users to access the resources on a shared recovery site, see Managing Permissions in a Shared Recovery Site Configuration in Site Recovery Manager Administration.

Prerequisites

- You installed Site Recovery Manager in a shared recovery site configuration.
- You connected the protected sites with the shared recovery site.
Familiarize yourself with the procedure for configuring placeholders and mappings. For information about configuring placeholders and mappings in a standard configuration, see *Site Recovery Manager Administration*.

### Procedure

1. In the vSphere Web Client, click **Site Recovery > Sites**, and select a site.

2. In the **Manage** tab, use the **Network Mappings**, **Folder Mappings**, **Resource Mappings**, **Storage Policy Mappings**, and **Placeholder Datastores** tabs to configure the mappings.

<table>
<thead>
<tr>
<th>Option</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Share customer resources</strong></td>
<td>Map the resources, networks, and datastores on the protected sites to a common datacenter, network, and placeholder datastore on the shared recovery site. You can create individual folders for each customer on the recovery site and map the folders on the protected sites to the individual folders.</td>
</tr>
<tr>
<td><strong>Isolate customer resources</strong></td>
<td>Map the resources, networks, folders, and datastores on the protected sites to separate datacenters, networks, folders, and placeholder datastores on the shared recovery site.</td>
</tr>
</tbody>
</table>

3. **(Optional)** If you use vSphere Replication, select the appropriate target datastores for the replica virtual machines when you configure replication.

   Avoid using the same datastore as the target for vSphere Replication as you use as the placeholder datastore for Site Recovery Manager.

<table>
<thead>
<tr>
<th>Option</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Share customer resources</strong></td>
<td>Select a common target datastore on the shared recovery site. You can create individual folders in the target datastore for each customer on the recovery site.</td>
</tr>
<tr>
<td><strong>Isolate customer resources</strong></td>
<td>Select a different datastore for each customer on the shared recovery site.</td>
</tr>
</tbody>
</table>

### Upgrade Site Recovery Manager in a Shared Recovery Site Configuration

You can upgrade existing Site Recovery Manager installations that use a shared recovery site.

When you upgrade a Site Recovery Manager installation that uses a shared recovery site, the same recommendations apply as for upgrading a standard one-to-one installation of Site Recovery Manager. See *Chapter 8 Upgrading Site Recovery Manager*.

Upgrade all of the protected sites before you upgrade the shared recovery site. When you upgrade all of the protected sites before you upgrade the shared recovery site, you can run recoveries on the shared recovery site if failures occur on a protected site during the upgrade process. If you upgrade vCenter Server on the shared recovery site before you upgrade all of the protected sites, you cannot perform recovery until you complete all of the upgrades.

Upgrade the protected sites in order of importance, upgrading the most important sites first and the least important sites last. For example, upgrade protected sites that run business-critical applications before you upgrade sites that are less vital to your operations.
Prerequisites

- Verify that you know the standard procedure for upgrading Site Recovery Manager. For information about a standard Site Recovery Manager upgrade, see Chapter 8 Upgrading Site Recovery Manager.
- Evaluate the importance of each protected site, and prioritize the upgrade of the sites accordingly.

Procedure

1. Upgrade vCenter Server on the most critical of the protected sites.
2. (Optional) If you use vSphere Replication, upgrade the vSphere Replication appliance that connects to the vCenter Server instance that you upgraded in Step 1.
3. Upgrade the Site Recovery Manager Server instance that connects to the vCenter Server instance that you upgraded in Step 1.
   - If you perform in-place upgrade of Site Recovery Manager Server, the installer obtains from the registry the Site Recovery Manager extension ID that you set during the previous installation. There is no option to modify the Site Recovery Manager extension ID during upgrade.
   - If you upgrade Site Recovery Manager Server with migration, you must specify the same Site Recovery Manager extension ID as you used for the previous installation.
4. (Optional) If you use array-based replication, upgrade the storage replication adapters (SRA) on the Site Recovery Manager Server host machine that you upgraded in Step 3.
5. Repeat Step 1 to Step 4 for each of the protected sites that connect to the shared recovery site.
6. Upgrade vCenter Server on the shared recovery site.
7. (Optional) If you use vSphere Replication, upgrade the vSphere Replication appliance on the shared recovery site.
8. Upgrade the Site Recovery Manager Server instance on the shared recovery site that is paired with the first protected site that you upgraded.
   - If you perform in-place upgrade of Site Recovery Manager Server, the installer obtains from the registry the Site Recovery Manager extension ID that you set during the previous installation. There is no option to modify the Site Recovery Manager extension ID during upgrade.
   - If you upgrade Site Recovery Manager Server with migration, you must specify the same Site Recovery Manager extension ID as you used for the previous installation.
9. (Optional) If you use array-based replication, upgrade the SRAs for this Site Recovery Manager Server instance on the shared recovery site.
10. Repeat Step 8 and Step 9 for each of the remaining Site Recovery Manager Server instances on the shared recovery site.
11. Upgrade the ESXi Server instances on the shared recovery sites and each of the protected sites.
12. Upgrade the virtual hardware and VMware Tools on the virtual machines on the ESXi Server instances.